
คู่มือการผลิตส่ือดิจิทัลด้วย 
โปรแกรม Adobe Captivate 3  

 
 

 
 

จัดทําโดย 
 

อุทยานการเรียนรู้ TK park 
สํานักบริหารและพัฒนาองค์ความรู้ (องค์กรมหาชน) 

มูลนิธิอินเตอร์เน็ตร่วมพัฒนาไทย 

     



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          1 

คําชี้แจง 

 
 สํานักงานอุทยานการเรียนรู (สอร.) รวมกับ มูลนิธิอินเทอรเน็ตรวมพัฒนาไทย จัดโครงการอบรม
พัฒนาทักษะการสรางสื่อดิจิทัลใหแก ครูอาจารย เพื่อผลิตสื่อการเรียนรูที่สรางสรรค ทันสมัย โดยในป พ.ศ. 
2552 ไดจัดฝกอบรมเชิงปฏิบัติการสรางสื่อดิจิทัลดวยโปรแกรม Desktop Author 4.0  (หลักสูตร 2 วัน) และ 
ในป พ.ศ. 2553 ไดจัดฝกอบรมเชิงปฏิบัติการสรางสื่อดิจิทัลดวยโปรแกรม Adobe Captivate 3  (หลักสูตร 2 
วัน)  และในปนี้ พ.ศ. 2554 เพื่อเปนการเปดโอกาสใหแกนิสิต นักศึกษา ที่จะจบออกไปเปนครู หรือ
ประกอบอาชีพเกี่ยวกับการศึกษา ใหความรู กับเด็ก นักเรียน และเยาวชน สอร.และมูลนิธิฯ จึงจัดใหมีการ
อบรมเชิงปฏิบัติการสรางสรรคส่ือดิจิทัล ดวยโปรแกรม Adobe Captivate 3  (หลักสูตร 2 วัน) เพื่อเปนการ
สงเสริมใหนิสิต นักศึกษา และครูผูผานการอบรมไดสรางสรรคผลงานดานการศึกษาที่นํามาใชไดจริง จึงได
จัดกิจกรรมประกวดสื่อดิจิทัล  โดยไดรับพระมหากรุณาธิคุณจากสมเด็จพระเทพรัตนราชสุดาฯ สยามบรม
ราชกุมารี พระราชทานรางวัลชนะเลิศ เปนประจําทุกป ตั้งแต ป พ.ศ. 2551 เปนตนมา 
                        
  คณะผูดําเนินงาน หวังเปนอยางยิ่งวา กิจกรรมการอบรมและการประกวดสื่อดิจิทัล นี้ จะเปนการ
จุดประกายใหแกนิสิต นักศึกษา และครูผูเร่ิมตนในการพัฒนาผลงานดานเทคโนโลยีสารสนเทศเพื่อ
การศึกษา ในการสรางสรรคส่ือดิจิทัลในรูปแบบใหมๆ ที่นาสนใจ เพื่อสงเสริมการเรียนรูสําหรับเด็กและ
เยาวชนตอไป 

 
 

คณะผูดําเนินงาน 
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ที่มาและความสําคัญ 

โครงการอบรมเชิงปฏิบัติการผลิตสื่อดิจิทัล โดยโปรแกรม Adobe Captivate 3 คร้ังที่ 2 

 

 สํานักงานอุทยานการเรียนรู (สอร.) หนวยงานภายในสังกัดสํานักงานบริหารและพัฒนาองคความรู (องคการ
มหาชน) สํานักนายกรัฐมนตรี  จัดตั้งขึ้นโดยมีวัตถุประสงคเพื่อเปนแหลงเรียนรูที่มุงเนนการปลูกฝงและสงเสริมนิสัยรัก
การอาน การเรียนรู และการแสวงหาความรูอยางสรางสรรคตลอดชีวิต เทคโนโลยีสารสนเทศเปนองคประกอบหนึ่งที่มี
สวนในการสนับสนุนการเรียนรูของเยาวชน  ชวยสงเสริมความคิดสรางสรรค และสามารถพัฒนาไปสูการสรางเปนวิชาชีพ
ไดในอนาคต ที่ผานมา สอร. รวมกับมูลนิธิอินเทอรเน็ตรวมพัฒนาไทย ซึ่งเปนองคกรที่ไมแสวงหาผลกําไร มีวัตถุประสงค
เพื่อสงเสริมการนําเทคโนโลยีสารสนเทศ และอินเทอรเน็ตมาใชใหเกิดประโยชน อยางสรางสรรคและปลอดภัย ไดรวมมือ
กันจัดอบรมพัฒนาทักษะดานคอมพิวเตอรใหแกครูและนักเรียน เพื่อผลิตสื่อการสอนที่ดี และทันสมัยสามารถกระจาย
ความรูไปสูเยาวชน นักเรียน บุคลากรในตางจังหวัดภูมิภาคตางๆ ของประเทศที่ยังขาดโอกาสในการไดรับเทคโนโลยีและ
สื่อการสอนที่ทันสมัยและเปนประโยชนอยางตอเนื่อง 

   
 โดยในปที่ผานมา พ.ศ. 2553 ฝายอุทยานการเรียนรูตนแบบและบริการจึงจัดโครงการอบรมสื่อการเรียนรู  

ทั้ง 4 ภูมิภาค เพื่อเปนการตอยอดใหครู นักเรียน ไดเรียนรูการทําสื่อการสอนที่เปนภาพเคลื่อนไหว อันจะทําใหบทเรียนเปน
ที่นาสนใจ กระตุนการอาน การคนควาหาความรูตอไป  โดยได รั บก า รตอบรั บ จ ากผู เ ข า อบรม เป นอย า ง ดี   
 

 ในปนี้ พ.ศ. 2554 เพื่อเปนการเปดโอกาสใหแกนิสิต นักศึกษา ที่จะจบออกไปเปนครู หรือประกอบอาชีพ 
เกี่ยวกับการศึกษา ใหความรู กับเด็ก นักเรียน และเยาวชนไดเรียนรูโปรแกรมในการสรางสื่อที่ทันสมัย และมีสื่อการเรียน 
การสอนที่ดี สํานักงานอุทยานการเรียนรู รวมกับ มูลนิธิอินเทอรเน็ตรวมพัฒนาไทย จึงจัดโครงการอบรมเชิงปฏิบัติการเชิง
ลึกใหกับนิสิต นักศึกษา เพื่อมาตอยอดความรู และเรียนรูเทคนิคใหมๆเพิ่มเติม ในการพัฒนาสื่อดิจิทัลมากยิ่งขึ้น 

    
วัตถุประสงค 

1.1 นิสิต นักศึกษา มีความรู ในการใชงานคอมพิวเตอร เทคโนโลยีไดอยางมีประสิทธิภาพ และพัฒนาศักยภาพ
สามารถนําความรูที่ไดไปประยุกตใชในการสอน เพิ่ม  ประสิทธิภาพในการสอนในชั้นเรียนเผยแพรความรู
ดานเทคโนโลยีสารสนเทศไปสู  เยาวชน และชุมชน 

1.2 เผยแพรความรู ความเขาใจในเรื่องของการนําเทคโนโลยีไปใชในการใน  การจัดการองคความรูไดอยาง
ถูกตอง 

1.3 เกิดการแลกเปลี่ยนผลงาน ระหวางนิสิต นักศึกษา และนักเรียนภูมิภาคตางๆ ทําใหเกิดการพัฒนาสื่อสาระ 
สรางสรรคที่จะเปนแหลงความรูใหหองสมุด 
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ตัวอยางการสรางสื่อดิจิทัล 1 ช้ิน (อยางงาย) ดวยโปรแกรม Adobe Captivate 3 

 

1. การสรางโครงการหรืองานชิ้นใหม (New Project)  

• คลิก Start >All Program >Adobe > Adobe Captivate 3  

หรือดับเบิ้ลคลิกท่ีไอคอน Adobe Captivate 3   และเมื่อเปดโปรแกรมแลวจะเกิดหนา

หนาจอ 

 

 

 

• เลือก Record new project คลิกท่ี  Record or create a new project > Other Project Types > 

Blank Project และกด OK เพื่อเร่ิมตนสรางงานใหมไดในหลายๆ รูปแบบ 
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รูปภาพขั้นตอนการสรางงานชิ้นใหมแบบ  Blank Project  

Record or create a new project > Other Project Types > Blank Project  กด OK 

 

• เม่ือคลิก OK จะเกิดหนาตางดงัรูป 

 

 

 
รูปภาพ หนาตางของ Blank project > Preset size เพื่อเลือกขนาดของหนาจอ 

กด OK 

คลิก Preset size เพื่อ

เลือกขนาดของหนาจอ

สื่อดิจิทัลท่ีเราตองการ 

เม่ือคลิกแลวจะมีขนาด

หนาจอในขนาดตางๆ 

ใหเราเลือก 
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• ในงานชิน้นี้ใหเลือกขนาดของหนาจอขนาด 640 x 480 แลวคลิก OK จะไดหนาจอดังนี้ ซ่ึงจะเปน

หนาจอในมุมมองการทํางานแบบ Storyboard 

 

 

 

 

 

 

 

 

 

 

 

 

จะไดสไลดงานใหม 1 สไลด 

แสดงรายละเอียด 

ขนาดหนาจอที่เราเลือก 

Project path แสดงถึง 

ตําแหนงที่เราเก็บงานชิ้นนี้ 
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• หลังจากนั้นใหเราเปล่ียนมุมมองการทํางานใหมจาก Storyboard เปน Edit จะไดหนาจอดังนี ้

 

 
 

 

Timeline - เปนสวนสําคัญที่ทําหนาที่ควบคุมการนําเสนอผลงานของ Movie โดยคาเริ่มตนของ

โปรแกรมจะตัง้ไวในแตละสไลดคือ 3 วินาที 

 

>>รายละเอียดของ Timeline 

ในการทํางานเกี่ยวกับการเคลื่อนไหวจะมีเวลาเขามาเกีย่วของ โดยวัตถุหนึ่งๆ จะแสดงกี่วนิาที 

Timeline จะเปนตัวควบคุมและกําหนด  โดยรายละเอียดตางๆ ของ Timeline มีดังนี ้

 

 

 

คลิกท่ี Edit Timeline
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>>การปรับลําดับการนําเสนอวัตถุบน Timeline 

เมื่อเราไดนําวตัถุตางๆ เขามาในหนาสไลด วัตถุนั้นจะปรากฏบน Timeline ซ่ึงวัตถุจะอยูบนเลเยอรซ่ึง

เราสามารถปรับการนําเสนอผลตางๆ ของช้ินงานนั้นๆ โดยใชเมาสคลิกและลากดังนี ้

 

• การเลื่อนเลเยอรวัตถุไปทางซายหรือขวา – เปนการปรับเวลาเริ่มตนและจุดสิ้นสุดของวัตถุ

นั้นๆ เราสามารถใชเมาสคลิกคางแลวลากไดเลยในเลเยอรของวัตถุที่เราตองการ 

 
 

ซอน/แสดงเลเยอร 

(Play) เพื่อดูตัวอยาง 

งานที่ทําปจจุบัน 

(Stop) เพื่อหยุดดู 

ตัวอยางงานที่ทํา 

ปจจุบัน  

เปนเสนของเวลา รูปรางหนาตาคลายไมบรรทัด มีหนวยเปนวินาที 
ล็อค/ปลดล็อคเลเยอร

เวลาทั้งหมดที่ใช

ในชิ้นงานปจจุบัน
(Mute) เปด/ปด 

เสียงตัวอยาง 

งานที่ทําปจจุบัน 

เลเยอร หรือ ชั้นงานที่มีวัตถุใดๆ อยูในชั้นงานนั้นๆ 

Playhead มีไวสําหรับบอกตําแหนงในการเลนวาอยูในตําแหนงใด 

end จุดสิ้นสุดของสไลด 
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• การเลื่อนเลเยอรวัตถุขึ้นบนหรือลงลาง – เปนการจัดลําดบัการซอนทับกัน โดยเลเยอรของ

วัตถุที่อยูบนจะทับเลเยอรของวัตถุที่อยูลาง เราสามารถใชเมาสคลิกคางแลวลากไดเลยใน 

เลเยอรของวัตถุที่เราตองการ 

 
 

• การปรับขนาดเลเยอรของวัตถุใหมีขนาดสัน้หรือยาว – เปนการเพิ่มหรือลดเวลาในการเสนอ

งานของวัตถุนัน้ๆ เราสามารถทําไดโดยการคลิกคางที่ตนหรือปลายของวัตถุนั้นๆ แลวลาก

เขาหรือยืดออก 

 
 

>>การทํางานของ Timeline กับการแสดงของสไลด 

 
 
 ตัวอยางของ Timeline ในรปูนี้ สามารถอธิบายการแสดงของสไลดไดวา 

1.Text Animation “ประวัติความเปนมามูลนิธิอินเทอรเนต็รวมพัฒนาไทย” จะเริ่มแสดง 
กอนและแสดงไปจนจบ 16 วินาท ี

2. Image “logo_ifdt.jpg” จะแสดงหลังจาก Text Animation “ประวัติความเปนมามูลนธิิ 
อินเทอรเน็ตรวมพัฒนาไทย”  เลนผานแลวไป 3 วินาที และจะแสดงไปจนจบ คือ 16 วินาท ี

3.สไลดแสดงไปทั้งหมด 16 วินาท ี
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2. การจัดการเกี่ยวกับหนาของสไลด 
 

2.1 เพิ่มหนาวาง (Blank Slide)  

 
• ถาเราตองการสรางหนาสไลดเพิ่มเติมนั้น วิธีการคือไปท่ี Insert > Blank Slide 
 

 
 

• เม่ือเลือก Blank Slide แลว ก็จะเกิดหนาสไลดเพิ่มขึ้นจํานวน 1 หนา 
 

 
 

 

Insert > Blank Slide 

หนาสไลดท่ีเพิ่มขึ้นมา 1 หนา
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2.2 การลบหนาสไลด (Delete Slide)  
 

• ไปยงัหนาสไลดท่ีเราตองการลบ โดยดูจากกรอบ Slides เสร็จแลวคลิกเพื่อเลือกสไลดท่ีตองการลบ 1 
คร้ัง จนขึ้นสฟีาลอมรอบกรอบสไลดท่ีเราตองการ 
 

 
 

 
 

• หลังจากนั้นไปท่ี Edit > Delete Slide หรือ คลิกขวาที่สไลดและเลือก Delete Slide 

        หรือ             

คลิกเลือกสไลด 1 คร้ัง จนขึ้นสีฟาลอมรอบกรอบสไลด 

Edit > Delete Slide

Delete Slide
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• เม่ือเลือกแลวจะเกิดหนาตางขึ้นมาเพื่อใหเรายืนยนัอีกคร้ังวาตองการลบหนาสไลดนี้ ก็กด Yes เพื่อ
ยืนยัน 
 

 
 
 
3. การเพิ่มวตัถุ (Object) ในรูปแบบตางๆ ลงในชิ้นงาน  
 หลังจากที่เราไดการสรางงานชิ้นใหม (New Project) ขึ้นมาเรียบรอยแลว ขั้นตอนตอมาก็คือ การใส
วัตถุตางๆ เพื่อตกแตงในชิ้นงาน ใหเกิดความสวยงาม และตอบสนองกบัผูใชในหลายๆ รูปแบบ ซ่ึงในคูมือ
เลมนี้จะขออธบิายการใชงานเครืองมือ 12 แบบ  
 
3.1 การสรางขอความแบบเคลื่อนไหว (Text Animation) 
 Text Animation เปนการสรางหัวขอเนื้อหาใหมีการเคลือ่นไหว เพื่อทาํใหดนูาสนใจมากยิ่งขึ้น โดย
ไฟลที่สรางขึ้นมาเปนไฟลมาตรฐานเดยีวกับ Adobe Flash  
 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Text Animation หรือ Insert > Text Animation 
 

   หรือ  
รูปภาพ การใส Text Animation 

กด Yes 

คลิกท่ี Text Animation 

Insert > Text Animation
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• เม่ือเราเลือก Text Animation แลวจะเกิดหนาตาง New Text Animation ดังรปู 

 
 
 
>> สวนประกอบของหนาตาง New Text Caption มีดังนี ้

แถบที่ 1 Text Animation ใชสําหรับจัดการเกี่ยวกับคุณสมบัติตัวอักษรตางๆ มีรายละเอียดดังนี ้
 

 
 
 
1.กรอบ - เปนที่ใชแสดงขอความที่เราพิมพเขาไปพรอมกับแอนิเมชัน่ที่เราเลือก 
2.Effect - ใชเลือกเอฟเฟกตแอนิเมชั่นตางๆ 
3.Text - เปนพื้นที่ที่ใหเราพิมพขอความตางๆ ที่เราตองการสรางแอนิเมชั่น 

1

2

3

4

5

3
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4.Change font - ใชสําหรับเปลี่ยนรูปแบบตัวอักษรตามที่เราตองการ  
5.Transparency – กําหนดความโปรงใสของ Text Animation โดยเราสามารถกําหนดคาไดตั้งแต 0-100 
โดย 100 เทากบั ความโปรงใสสูงสุด หรือ สามารถมองผานได 
6.Deley – กําหนดความหนวง หรือ ความชาของแอนิเมชั่นของเรา คือ ยิ่งตัวเลขมาก ยิ่งทําใหการเลนชาลง 
 
แถบที่ 2 Option  ใชสําหรับกําหนดลูกเลนดานเอฟเฟกต 

 
 

1.Timing เปนการกําหนดระยะเวลาในการแสดงขอความแอนิเมชั่น มีรายละเอียดดังนี้ คือ 

Display for ใชกําหนดระยะเวลาในการแสดงขอความวาเราตองการใหแสดงขอความนานเทาใด 

โดยมีตัวเลือกดังนี ้

- specific time  เปนการกําหนดระยะเวลาวาตองการแสดงนานเทาใด โดยกรอกตวัเลขเขา 

ไป มีหนวยเปนวินาท ี

- rest of slide  เปนการกําหนดใหขอความแสดงเทากับระยะเวลาของสไลดนั้นๆ 

- rest of project  เปนการกําหนดใหขอความแสดงเทากับระยะเวลาของทั้งชิ้นงาน  

- duration of Animation  เปนการกําหนดให Text Animation เลนเทากับความยาวของ 

แอนิเมชั่น 

Appear after เปนการตั้งคาวาจะใหขอความนี้เร่ิมแสดงเมื่อถึงวินาทีที่เทาไหร เชน ถาเราตั้งคาที่ 

0.00 วินาที หมายความวาขอความนี้จะเริม่ขึ้นมาพรอมสไลดเร่ิมแรกเลย ถาเราตั้งคา 2.00 วินาที หมายความ

วาเมื่อสไลดเลนผานไปแลว 2 วินาที ขอความถึงจะปรากฏขึ้นมา 

1. 

2. 
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Loop กําหนดใหแอนิเมชั่นเลนวนตลอด 

2.Transition เปนการกําหนดการแสดงวาใหใชเอฟเฟกต (Effect) กับขอความนี้หรือไม มีรายละเอียดดังนี้ 

คือ 

- Fade in and out กําหนดใหมีการใชเอฟเฟกตในการคอยๆ ปรากฏออกมา แลวคอยๆ จาง 

หายไป โดยเราสามารถกําหนดระยะเวลาไดที่  In และ Out โดยโปรแกรม 

กําหนดคาเริ่มตนมาใหที่ 0.5 วินาท ี

-Fade in only  กําหนดใหมีการใชเอฟเฟกตในการคอยๆ ปรากฏออกมาเพียงอยางเดยีว 

และไมมีเอฟเฟกตการคอยๆ จางหายไป โดยเราสามารถกําหนดระยะเวลา 

ไดที่  In  

-Fade out only  กําหนดใหมีการใชเอฟเฟกตในการคอยๆ จางหายไป เพยีงอยางเดียว และ 

ไมมีเอฟเฟกตการปรากฏออกมา โดยเราสามารถกําหนดระยะเวลาไดที่

Out 

-No transition  ไมมีการใชเอฟเฟกตใดๆ 

 
แถบที่ 3 Audio ใชสําหรับกําหนดเสยีงในการใชงาน เชน สามารถบันทึกเสียงสด ณ เวลานั้น หรือ การนํา

เสียงตางๆ ที่เรามีอยูเขามาใช 

 

 

 

 

 



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          15 

โดยในแตละปุมมีรายละเอียดดังนี ้

 

ปุมคําสัง่ การใชงาน 

 (Play) เพื่อเลนไฟลเสียงที่เลือก 

 (Stop) เพื่อหยดุไฟลเสียงที่เลือก

 (Delete) เพื่อลบไฟลเสียงที่เลือก

 (Edit) เพื่อแกไขไฟลเสียงที่เลือก

 
(Recoard New…) การนําเสียงเขามาใชงานโดยการ

บันทึกเสียง 

 (Import)  การนําไฟลเสียงทีม่ีอยูเขามาใชงาน 

เปนกรอบที่จะแสดงรายละเอยีดของไฟลเสยีงที่เราเลือก (ช่ือ

ของไฟลเสียง , ระยะเวลาของไฟลเสียง) 

 

 

(Select audio from library) การนําเสียงเขามาใชงานโดยการ

การนําเสียงทีม่ีอยูแลวใน Library ของชิ้นงาน หรือ โครงการ 

(Project) ที่เราทํา 

 (Setting) การกําหนดเงื่อนไขตางๆ ของไฟลเสียง 

 
(Fade Out) การตั้งคาเวลาการใชเอฟเฟกตในการคอยๆ 

ปรากฏออกมาของเสียง 

 
(Fade in) การตั้งคาเวลาการใชเอฟเฟกตในการคอยๆ จาง

หายไปของเสยีง 
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แถบที่ 4 Size and Position สําหรับกําหนดตําแหนง และขนาดของวัตถุ 

 

Position in pixels หมายถึงการกําหนดตําแหนงของรูปภาพ มีหนวยเปน Pixel 

Size in pixels ความกวาง (Width) และยาว (Height) ของงาน 

 

• ใหพิมพและปรับแตงขอความขอความตามที่เราตองการ เม่ือเสร็จแลวกด OK 
 

 
 

 

• เม่ือกด OK แลวจะได Text Animation บนสไลดในตําแหนงกลางสไลด และจะปรากฏ Timeline 

ของ Text  Animation ขึ้นมา เพื่อควบคุมการนําเสนอ Text Animation ซ่ึงสามารถปรับจุดเริ่มต

นและจุดสิ้นสุดการนําเสนอไดอยางอิสระ **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับ

ลําดับการนําเสนอวัตถุบน Timeline หนาท่ี 6-8) ** 

กด OK 
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• ทําการปรับ Text Animation ใหเปนไปตามความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Text Animation 

- ถาตองการแกไขเกี่ยวกับตวัอักษรและเอฟเฟกต > กดดับเบิ้ลคลิกในสวนของขอความ

นั้นๆ   

 

 

Text Animation บนสไลด เกิด Timeline ของ Text  Animation ขึ้นมา 
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3.2  การใสรูปภาพ (Image) 

เราสามารถเพิ่มรูปภาพเขามาในชิ้นงานเพือ่ใหเกิดความสวยงาม หรือใชในการประกอบการอธิบาย
ส่ิงตางๆ ไปจนถึงนํามาเปนฉากหลังไดอีกดวย 

 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Image หรือ Insert >  Image 
 

      หรือ      
 คลิกท่ี Image 

Insert > Image
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• จะไดหนาตาง Open ใหเลือกตําแหนงท่ีเก็บภาพและเลือกภาพตามตองการแลวกด Open ดังนี ้
 

 
 
 

• เม่ือกด Open แลวจะไดหนาตาง New Image Box  ดังรปู 
 

 
 

 

กด Open
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>> สวนประกอบของหนาตาง New Image Box มีดังนี ้

แถบที่ 1 Image ใชสําหรับจดัการเกีย่วกับคุณสมบัติตางๆ รูปภาพ มีรายละเอียดดังนี ้
 

 
 

1. Appearance นี้ เราสามารถที่จะกําหนดสิ่งตางๆ กับ Image 

- Transparency   กําหนดคาความโปรงใสของภาพ โดยใสตวัเลข 0-100  (100 คือ  
ภาพโปรงใสมากที่สุด) 

- Transparent background กําหนดคาความโปรงใสของแบล็คกราวด หรือเปนเครื่องในการ 
ตัดฉากหลังของภาพออก โดยถาเราตองการตัดฉากหลังออกก็
ใหติ๊กที่ชองสี่เหล่ียมหนา Transparent background และเลือกสี
ของแบล็คกราวดที่เราตองการตัดออกไดทีก่ลองจานสี 

2.Preview แสดงตัวอยางที่ของคาที่เราตั้งใน Appearance 
 
 

** กรณีท่ีแทรกรูปท่ีมีขนาดใหญกวาสไลดท่ีเรากําหนดไว โปรแกรมจะแสดงหนาตางดังนี้ ** 
 

2  

1 
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Crop คือตัดภาพใหมีขนาดพอดีกับสไลด โดยที่อาจทําใหสวนใดสวนหนึ่งของรูปขาดหายไป  
Resize คือการยอภาพใหพอดีกับสไลด โดยที่ภาพจะมีขนาดไฟลภาพที่เล็กลงและความสมบูรณของภาพ
ยังคงอยู 
 

                 
รูปภาพ การ Crop     รูปภาพ การ Resize 

 
** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

จุดท่ีแตกตางคอื 

-หนาตาง Image Caption แถบที่ 2  Option > Display for จะไมมี Duration of Animation 

-หนาตาง Image Caption แถบที่ 2  Option จะไมมี Loop 
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• เม่ือกด OK แลวจะได Image บนสไลดในตําแหนงกลางสไลด และจะปรากฏ Timeline ของ Image 

ขึ้นมา เพื่อควบคุมการนําเสนอ Image ซ่ึงสามารถปรับจดุเริ่มตนและจุดสิ้นสุดการนาํเสนอไดอยาง

อิสระ  **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดับการนําเสนอวัตถุบน Timeline 

หนาท่ี 6-8) ** 

 
 

 
 

• ทําการปรับตาํแหนงและขนาดของ Image ไดโดยใหใชเมาสคลิกท่ี Image จะสามารถทําการปรับ

ขนาดยอหรือขยายและนําไปจัดวางในตําแหนงตามตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนงของรูป > ใชเมาสคลิกท่ี Image 
- ถาตองการแกไขเกี่ยวกับคณุสมบัติและคาตางๆ ของรูป > กดดับเบิ้ลคลิกท่ี Image  

 

• เราสามารถปรบัขนาดของรปูโดยการคลิกท่ีปุมแฮนเดิลแลวลากเพื่อปรับขนาดของรปู 
ตามตองการ ดังรปู 
 

เกิด Timeline ของ Image ขึ้นมา Image บนสไลด 
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• เม่ือเราจัดวางไวในตาํแหนงท่ีเราตองการแลว เราสามารถดูตัวอยางงานได โดย กด F3 เพื่อแสดง
สไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้งโปรเจ็กต 
 

3.3 การใสปุม (Button) 
 เปนวัตถุที่ชวยตอบสนองกับผูใชงาน เพื่อกาํหนดใหผูใชงานเลือกทําอยางใดอยางหนึง่ เชน เพื่อ
ควบคุมการนําเสนอใหกับสไลดได เชน ปุม Next, ปุม Back, ปุมเมนู ฯลฯ สําหรับเลือกเนื้อหาตามตองการ 
หรือปุมควบคมุสไลดใหหยดุในตําแหนงที่ตองการ เปนตน  
 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Button หรือ Insert > Button 
 

      หรือ      
 คลิกท่ี Button 

Insert > Button
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•  เม่ือเราเลือก Button แลวจะเกิดหนาตาง New Button ดังรปู 

 
 
 
>> สวนประกอบของหนาตาง New Button มีดังนี ้

แถบที่ 1 Button ใชสําหรับจัดการเกี่ยวกบัคุณสมบัติตางๆ ของปุม มีรายละเอียดทั้งหมด 4 สวน แตจะขอ
อธิบายในสวนเบื้องตนที่ควรรู 2 สวน ดังนี้ 
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1.Button type รูปแบบของปุม มี 3 รูปแบบดังนี้  

1.1 Text Button เปนปุมที่เราสามารถพิมพขอความไวกับปุมได โดยกรอกขอความตรงที่ Button 
Text  ที่เราสามารถกําหนดรปูแบบ ขนาด สี และอื่นๆ ของตัวอักษรไดที่ปุม ดังรูป 

ถาเราทําเครื่องหมายหนา Transparent จะทาํใหปุมกลายเปนแบบโปรงใส ** ซ่ึงเราสามารถใชทํา
ลิงคเพื่อสรางสารบัญได ** 
 

 
รูปภาพ แบบ Text Button 

 
1.2 Transparent Button เปนปุมโปรงใส ซ่ึงเราสามารถกําหนดคาตางได ดังนี ้

 

 
รูปภาพ แบบ Transparent Button 

 
 

1

2 
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- Frame color กําหนดสีของกรอบ  
- Frame width กําหนดขนาดความหนาของกรอบ 

- Fill color กําหนดสีพื้น 

- Fill transparent  กําหนดความโปรงใส โดยใสตัวเลข 0-100  (100 คือ ภาพ 
โปรงใสมากที่สุด) 

 

1.3 Image Button เปนปุมสําเร็จรูปที่ทางโปรแกรมเตรียมไวให 
 

 
รูปภาพ แบบ Image Button 

 
2.If  the user clicks on the button คือ On success เมื่อมีการกดปุมแลวเราตองการใหปุมนั้นทําอะไร โดยมี
รายละเอียดดังนี้ 
  - Continue      ใหนําเสนอเนือ้หาตอไป 

- Go to previous slide   ถอยกลับสไลดกอนหนา 
- Go to next slide  ไปสไลดถัดไป 
- Jump to slide    เล่ือนไปสไลดที่ระบุ 
- Open URL or file   เปดไฟลหรือเว็บไซต 
- Open other project  เปดโครงงานอื่นๆ 
- Send e-mail to   สงอีเมล 
- Execute JavaScript    เรียกใชงาน JavaScript 
- No action      ไมมีผลใดๆ 

 
แถบที่ 2 Option ใชสําหรับเพิ่มความสามารถใหกับปุมเพิ่มเติม โดยสามารถกําหนดรายละเอียดดังนี้ 
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1.Timing เปนการกําหนดระยะเวลาในการแสดงขอความแอนิเมชั่น มีรายละเอียดดังนี้ คือ 

Display for ใชกําหนดระยะเวลาในการแสดงขอความวาเราตองการใหแสดงขอความนานเทาใด 

โดยมีตัวเลือกดังนี ้

-specific time เปนการกําหนดระยะเวลาวาตองการแสดงนานเทาใด โดยกรอกตวัเลขเขา 

ไป มีหนวยเปนวินาท ี

-rest of slide เปนการกําหนดใหขอความแสดงเทากับระยะเวลาของสไลดนั้นๆ 

Appear after เปนการตั้งคาวาจะใหขอความนี้เร่ิมแสดงเมื่อถึงวินาทีที่เทาไหร เชน ถาเราตั้งคาที่ 

0.00 วินาที หมายความวาขอความนี้จะเริม่ขึ้นมาพรอมสไลดเร่ิมแรกเลย ถาเราตั้งคา 2.00 วินาที หมายความ

วาเมื่อสไลดเลนผานไปแลว 2 วินาที ขอความถึงจะปรากฏขึ้นมา 

2.Option เปนสวนที่เราเลือกหรือไมเลือกก็ได โดยมีหวัขอตางๆ ดังนี้ 
- Success caption ใหแสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความยนิดี เมื่อคลิก

ปุมไดถูกตอง 
- Failure caption ใหแสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความผิดพลาด เมื่อ

คลิกปุมผิด 
- Hint caption  ใหแสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิกปุม 
- Pause for success/failure captions กําหนดใหหยดุแสดงขอความอธิบาย (Text Caption) ที่

บอกแสดงความยินด ีและความผิดพลาด 
- Stop slide audio when clicked  ใหหยุดเสยีงสไลดเมื่อคลิก 
- Double mouse click   กําหนดใหตองกดปุมโดยการดับเบิ้ลคลิก 
 

1 

2 
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** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

** ในแถบของ Reporting เปนสวนท่ีใชในการสรางแบบทดสอบ โดยจะกลาวถึงในเรื่องของการสราง

แบบทดสอบตอไป** 

• ในตัวอยางชิ้นงานนี้ จะเลือกใชปุมสาํเร็จรูปท่ีโปรแกรมมีมาให และใหปุมนี้ทํางาน Go to next slide 
หรือ เพื่อใหไปยังสไลดถดัไป ดงัรูป 

 

 
 

 

• เม่ือกด OK แลวจะได Button บนสไลดในตําแหนงกลางสไลด และจะปรากฏ Timeline ของ 

Button ขึ้นมา เพื่อควบคุมการนําเสนอ Button ซ่ึงสามารถปรับจุดเริ่มตนและจุดสิ้นสุดการ

นําเสนอไดอยางอิสระ  **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดับการนําเสนอวัตถุ

บน Timeline หนาท่ี 6-8) ** 

 

กด OK 
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• ทําการปรับ Button ใหเปนไปตามความตองการ 

- ถาตองการปรับตําแหนง > ใชเมาสคลิกท่ี Button 

- ถาตองการแกไขเกี่ยวกับปุมและการทํางานของปุม > กดดับเบิ้ลคลิกท่ี Button  

 

 

Button บนสไลด เกิด Timeline ของ Button ขึ้นมา 
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• เม่ือเราจัดวางไวในตาํแหนงท่ีเราตองการแลว เราสามารถดูตัวอยางงานได โดย กด F3 เพื่อแสดง

สไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้งโปรเจ็กต 

 

** เม่ือเราสามารถสรางปุมดงัตัวอยางไดแลว 

เราสามารถนําวิธีเดียวกันนี้ไปประยุกตเพื่อสรางปุมท่ีมีการทํางานอื่นๆ ไดอีก ** 

 

3.4 การใสขอความ (Text Caption) 
เปนขอความทีใ่ชอธิบายสิ่งตางๆ ที่เราตองการ 

 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Caption หรือ Insert > Text Caption 
 

     หรือ     

 

 

 

คลิกท่ี  Caption 

Insert > Text Caption
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• เม่ือเราเลือกText Caption แลวจะเกิดหนาตาง New Text Caption ดังรูป 

 
รูปภาพ หนาตาง New Text Caption  

 

>> สวนประกอบของหนาตาง New Text Caption มีดังนี ้

แถบที่ 1 Text Caption  ใชสําหรับจัดการเกี่ยวกับตวัอักษรตางๆ มีรายละเอียดดังนี ้

 

 

 

 



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          32 

ปุมคําสัง่ การใชงาน 

 
รูปแบบของกรอบขอความ 

การเลือกรูปแบบตัวอักษร ถาใชภาษาไทยควรจะเลือกรูปแบบ

ตัวอักษรที่รองรับภาษาไทยดวย เชน MS Sans Serif, Cordia 

New หรือ กลุมที่ลงทาย UPC เปนตน  

 
กําหนดขนาดตัวอักษร 

 กําหนดสีตัวอักษร 

 ระบายสีเพื่อเนนขอความ 

 การกําหนดตวัอักษรใหตัวหนา ตัวเอยีง และขีดเสนใต 

 การกําหนดชิดซาย กึ่งกลาง ชิดขวา ของขอความ 

 การกําหนดระยะหางของบรรทัด 

 สัญลักษณหรือตัวเลขนําหนาขอความ 

 การจัดการเยื้องบรรทัด 

 การใสสัญลักษณตางๆ 

 การกําหนดการวางตัวอักษรใหชิดขอบบน กึ่งกลาง ขอบลาง  

 

** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 
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จุดท่ีแตกตาง คือ  

-หนาตาง Text Caption แถบที่ 2  Option > Display for จะไมมี Duration of Animation 

-หนาตาง Text Caption แถบที่ 2  Option จะไมมี Loop 

 

• ใหพิมพและปรับแตงขอความขอความตามที่เราตองการ เม่ือเสร็จแลวกด OK  

** สําหรับการใสขอความแบบไมมีกรอบขอความใหเลือก Caption type เปนแบบ Transparent ** 

 

 

• เม่ือกด OK แลวจะได Text Caption บนสไลดในตําแหนงกลางสไลด และจะปรากฏ Timeline ของ 

Text  Caption ขึ้นมา เพื่อควบคุมการนําเสนอ Text Caption ซ่ึงสามารถปรับจุดเริ่มตนและ

จุดสิ้นสุดการนําเสนอไดอยางอิสระ **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดับการ

นําเสนอวัตถุบน Timeline หนาท่ี 6-8) ** 

 

 

 

 กด OK 
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• ทําการปรับ Text Caption ใหเปนไปตามความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Text Caption  

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   

 

 

เกิด Timeline ของ Text  Caption ขึ้นมา Text Caption บนสไลด 
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• เม่ือเราจัดวางไวในตาํแหนงท่ีเราตองการแลว เราสามารถดูตัวอยางงานได โดย กด F3 เพื่อแสดง

สไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้งโปรเจ็กต 

 

3.5 การสรางขอความอธิบายแบบเปลี่ยนสถานะ (Rollover Caption) 

เปนขอความทีจ่ะแสดงขึน้มาใหเห็นก็ตอเมือ่ผูใชนําเคอรเซอรเมาสวางหรือผานในบริเวณ (Rollover 

Area) ซ่ึงมักใชกับการอธิบายรูปภาพเพิ่มเติม หรือ ขยายรายละเอียดของขอความเพิ่มเติม 

 

 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Caption หรือ Insert > Text Caption 
 

        หรือ         

 

 

 

 

คลิกท่ี Icon Rollover Caption 

Insert > Rollover Caption
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• จะไดหนาตาง New Rollover Caption ดังรปู 

 
รูปภาพ หนาตาง New Rollover Caption 

** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

จุดท่ีแตกตางคอื 

- หนาตาง New Rollover Caption แถบที่ 2  Option จะมีแค Transition – Effects 

• ใหพิมพและปรับแตงขอความขอความตามที่เราตองการ เม่ือเสร็จแลวกด OK 

 
 

 กด OK 
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• เม่ือกด OK แลวจะพบกับวัตถุ 2 ชิ้น นั่นกค็ือ 1.Rollover Caption และ 2.Rollover Area บนสไลด

ในตําแหนงกลางสไลด และ จะปรากฏ Timeline ของ Rollover Area ขึ้นมา เพื่อควบคุมการ

นําเสนอ Rollover Caption และ Rollover Area ซ่ึงสามารถปรับจุดเริ่มตนและจุดสิ้นสุดการ

นําเสนอไดอยางอิสระ 

 

 
 

• ใหเราคลิกเลือก Rollover Area ไปวางครอบในสวนท่ีเราตองการ ในทีน่ี้ตองการใหเวลาท่ีนํา

เคอรเซอรเมาสไปวางไวท่ีรูปภาพ (ใหเรา Insert > image เขามา) แลวจะแสดงขอความวา “ภาพ

บรรยากาศการอบรม E-Book”  ดังนัน้ ใหเราคลิกเลือกท่ีกลองของ Rollover Area ซ่ึงสามารถยอ-

ขยายไดตามความตองการ นําไปครอบคลุมรูปภาพ และในสวนของ Rollover Caption ก็สามารถที่

จะยายหรือปรับไดตามความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Rollover Area, 

Rollover Caption 

- ถาตองการแกไขเกี่ยวกับคณุสมบัติตางๆ > กดดับเบิ้ลคลิกท่ี Rollover Area, Rollover 

Caption 

1.Rollover Caption บนสไลด 

2.Rollover Area 

บนสไลด

เกิด Timeline ของ Rollover Caption ขึ้นมา
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รูปภาพ เม่ือปรับแตง Rollover Caption และ Rollover Area ตามความตองการเรียบรอยแลว 

 

• เม่ือเราจัดวางไวในตาํแหนงท่ีเราตองการแลว เราสามารถดูตัวอยางงานได โดย กด F3 เพื่อแสดง

สไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้งโปรเจ็กต **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี 

เร่ือง การปรับลําดับการนําเสนอวัตถุบน Timeline หนาท่ี 6-8) ** 

 

3.6 การสรางกรอบเนน (Hilight Box) 

เปรียบไดกับปากกาเนนขอความ ที่ถาเราตองการเนนตรงสวนไหนแสดงวาสวนนั้นเปนจุดสําคัญ
หรือจุดที่นาสนใจ 

 
 
 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Hilight Box หรือ Insert >  Hilight Box 
 
 
 
 
 
 

กรอบสีสม คือ

Rollover Area

ท่ีนํามาคลุม

Rollover Caption คือ 

ขอความท่ีแสดงขึ้นมา

เม่ือนําเคอรเซอรเมาสไป

วางไวบริเวณ Rollover 

Area ท่ีอยูบนรูปภาพ
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      หรือ      
 
 

• จะไดหนาตาง New Hilight Box ดังรูป 

 

>> สวนประกอบของหนาตาง New Hilight Box มีดังนี ้

คลิกท่ี Hilight Box

Insert > Hilight Box 
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แถบที่ 1 Hilight Box ใชสําหรับจัดการเกีย่วกับกรอบและสีของ Hilight Box ตางๆ มีรายละเอียดดังนี ้

 
 

 

1.Appearance นี้ เราสามารถที่จะกําหนดสิ่งตางๆ กับ Hilight Box 

-  Border color  กําหนดสีของกรอบ  
-  Border width  กําหนดขนาดความหนาของกรอบ 

-  Fill color  กําหนดสีพื้น 

- Fill transparent  กําหนดความโปรงใส โดยใสตัวเลข 0-100  (100 คือ ภาพ 
โปรงใสมากที่สุด) 

- Fill outer area  ทําใหสวนที่อยูนอกกรอบเนนนั้นถูกบัง และทําใหส่ิงทอยูใน 
กรอบเนนเดนขึ้นมา 

2.Preview แสดงตัวอยางที่ของคาที่เราตั้งใน Appearance 
 

** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

 

 

1  

2  
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จุดท่ีแตกตาง คือ  

-หนาตาง Hilight Box แถบที่ 2  Option > Display for จะไมมี Duration of Animation 

-หนาตาง Hilight Box แถบที่ 2  Option จะไมมี Loop 

 

• เม่ือเราปรับแตงกรอบและสีพื้นเรียบรอยแลวกด OK แลว จะได Hilight Box บนสไลดในตาํแหนงก

ลางสไลด และ จะปรากฏ Timeline ของ Hilight Box ขึ้นมาเพื่อ 1 เลเยอร เพื่อควบคุมการนําเสนอ 

Hilight Box ซ่ึงสามารถปรบัจุดเริ่มตนและจุดสิ้นสุดการนําเสนอไดอยางอิสระ **(สามารถดู

รายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดบัการนําเสนอวัตถุบน Timeline หนาท่ี 6-8) ** 

 

 

 
 
 
 
 

 

เกิด Timeline Hilight Box ขึ้นมา Hilight Box บนสไลด 
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• ใหเราคลิกเลือก Hilight Box ไปวางครอบในสวนท่ีเราตองการเนนเพื่อใหเกิดจุดสนใจ ในที่นี้

ตองการใหไปวางไวครอบคลุมท่ีรูปภาพ (ใหเรา Insert > image เขามา) ซ่ึงสามารถทํา Hilight Box 

ได 2 แบบ และสามารถปรับ Hilight Box ใหเปนไปตามความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Hilight Box 

- ถาตองการแกไขคุณสมบตัติางๆ > กดดับเบิ้ลคลิกท่ี Hilight Box 

 

 

   
รูปภาพ การสรางกรอบเนนและการแสดงผลแบบไมใช Fill outer area (จะเกิดสีท่ีอยูในกรอบซึ่งทับรูปภาพ) 

 
 

 
 

                     
 

รูปภาพ การสรางกรอบเนนและการแสดงผลแบบใช Fill outer area  
(จะเกิดสีท่ีอยูนอกกรอบซึ่งไมทับรูปภาพ ทําใหรูปท่ีอยูในกรอบเดนขึ้นมา) 

 

Hilight Box แบบไมใช Fill 

outer area ไปวางคลุมท่ีรูปภาพ 

Hilight Box แบบใช Fill outer 

area ไปวางคลุมท่ีรูปภาพ 
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• เม่ือเราเลือกรูปแบบของกรอบเนนท่ีเราตองการไดแลว เราสามารถดูตวัอยางงานได โดย กด F3 เพื่อ

แสดงสไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทัง้โปรเจ็กต 

 
3.7 การสรางกรอบขยาย (Zoom Area) 

เปรียบไดกับแวนขยาย คือสามารถทําใหพืน้ที่บางสวนขยายใหญขึ้นมา ซ่ึงจะขยายในพื้นที่บริเวณที่
เรากําหนด เปนการเนนใหผูชมเขาใจและสนใจในสิ่งที่เราตองการนําเสนอมากยิ่งขึน้  

 
 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Zoom Area หรือ Insert >  Zoom Area 
 

     หรือ      
 

 
 
 
 
 
 
 
 

คลิกท่ี  Zoom Area 

Insert > Zoom Area
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• จะไดหนาตาง New Zoom Area ดังรูป 

 

 

>>สวนประกอบของหนาตาง  Zoom Area มีดังนี ้

แถบที่1 Zoom Destination Area ใชสําหรับจัดการเกี่ยวกับกรอบและสีพื้นตางๆ ของ Zoom Area คือ 

 

1.Appearance นี้ เราสามารถที่จะกําหนดสิ่งตางๆ กับ Zoom Area 

- Border color กําหนดสีของกรอบ  
- Border width กําหนดขนาดความหนาของกรอบ 

1  

2  
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- Fill color กําหนดสีพื้น 

- Fill transparent  กําหนดความโปรงใส โดยใสตัวเลข 0-100  (100 คือ ภาพ 
โปรงใสมากที่สุด) 

- ปุม Select image… ใชเพิ่มลูกเลนใหกรอบขยายถาเราตองการใหรูปที่มีอยู กบัรูป 
สวนที่ถูกขยายออกมานัน้เปนคนละรูป 

2.Preview แสดงตัวอยางที่ของคาที่เราตั้งใน Appearance 

 

** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

จุดท่ีแตกตาง คือ  

-หนาตาง Zoom Destination Area แถบที่ 2  Option > Display for จะไมมี Duration of Animation 

-หนาตาง Zoom Destination Area แถบที่ 2  Option จะไมมี Loop 

 

• เม่ือเราปรับแตงกรอบและสีพื้นเรียบรอยแลวใหกด OK และเมื่อกด OK แลวจะพบกับวัตถุ 2 ชิ้น 

นั่นก็คือ 1. Zoom Area และ 2. Zoom Destination Area บนสไลดในตาํแหนงกลางสไลด และ จะ

ปรากฏ Timeline ของ Zoom Area ขึ้นมาเชนกัน เพื่อควบคุมการนําเสนอ Zoom Area และ Zoom 

Destination Area ซ่ึงสามารถปรับจุดเริ่มตนและจุดสิ้นสุดการนําเสนอไดอยางอิสระ **(สามารถดู

รายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดบัการนําเสนอวัตถุบน Timeline หนาท่ี 6-8) ** 
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1. Zoom Area เปนกรอบที่เราใชครอบบริเวณทีต่องการขยาย 

2. Zoom Destination Area เปนกรอบที่ใชเปนพื้นทีแ่สดงสิ่งที่เราตองการขยาย  

 

• ใหเราคลิกเลือก Zoom Area ไปวางครอบในสวนท่ีเราตองการขยายเพื่อใหเกิดจุดสนใจ  ซ่ึงในที่นี้

ตองการขยายรูปกีตารบนรูปภาพใหใหญขึ้น (ใหเรา Insert > image เขามา) เราควรนํา Zoom Area 

ไปวางไวบนรปูกีตาร ซ่ึงก็จะทําใหเกิดภาพขยายขึ้นท่ี Zoom Destination Area ใหเราทําการปรับ 

Zoom Area และ Zoom Destination Area ใหเปนไปตามความตองการ 

- ถาตองการปรบัขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Zoom Area และ Zoom  

Destination Area  

- ถาตองการแกไขเกี่ยวกับคณุสมบัติตางๆ > กดดับเบิ้ลคลิกท่ี Zoom Area และ Zoom  

Destination Area 

เกิด Timeline ของ Zoom Area ขึ้นมา 

1. Zoom Area 2. Zoom Destination Area 
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• เม่ือเราเลือกรูปแบบของกรอบเนนท่ีเราตองการไดแลว เราสามารถดูตวัอยางงานได โดย กด F3 เพื่อ
แสดงสไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทัง้โปรเจ็กต 

 
3.8 การสรางรปูภาพแบบเปลี่ยนสถานะ (Rollover Image) 
 เปนการเพิ่มความสนใจใหกบังาน เพราะจะเปนการแสดงรูปภาพเมื่อนาํเคอรเซอรเมาสไปวางไวใน
พื้นที่ที่เราทําบริเวณไว 
 
 
 
 
 
 
 
 
 
 

Zoom Destination Area จะ

แสดงภาพในสวนที่ Zoom Area 

ไปครอบคลุมพื้นที่นั้นอยู 

Zoom Area ใชครอบใน

สวนที่เราตองการขยาย 
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• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Rollover Image หรือ Insert >  Rollover Image 
 
 

    หรือ      

 

 

• จะเกิดหนาตางเพื่อใหเราเลือกรูปภาพทีต่องการนํามาใชในการทํา Rollover Image เม่ือเลือกรูปได

แลวใหกดปุม Open  

 

คลิกท่ี  Rollover Image

Insert > Rollover Image
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** กรณีที่แทรกรูปที่มีขนาดใหญกวาสไลดที่เรากําหนดไว โปรแกรมจะแสดงหนาตางดังนี้ ** 
 

 
 
 

Crop คือตัดภาพใหมีขนาดพอดีกับสไลด โดยที่อาจทําใหสวนใดสวนหนึ่งของรูปขาดหายไป  
Resize คือการยอภาพใหพอดีกับสไลด โดยที่ภาพจะมีขนาดไฟลภาพที่เล็กลงและความสมบูรณของภาพ
ยังคงอยู 
 

• เม่ือแทรกรูปภาพเขามาไดเรียบรอยแลวจะไดหนาตาง New Rollover Image ดังรปู 
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>> สวนประกอบของหนาตาง Rollover Image มีดังนี ้

แถบที่ 1 Rollover Image ใชสําหรับจัดการเกี่ยวกับคณุสมบัติตางๆ ของ Rollover Image คือ 

 
 

1. Appearance นี้ เราสามารถที่จะกําหนดสิ่งตางๆ กับ Rollover Image 

-Transparency   กําหนดคาความโปรงใสของภาพ โดยใสตวัเลข 0-100  (100 คือ  
ภาพโปรงใสมากที่สุด) 

- Transparent background กําหนดคาความโปรงใสของแบล็คกราวด หรือเปนเครื่องในการ 
ตัดฉากหลังของภาพออก โดยถาเราตองการตัดฉากหลังออกก็
ใหติ๊กที่ชองสี่เหล่ียมหนา Transparent background และเลือกสี
ของแบล็คกราวดที่เราตองการตัดออกไดทีก่ลองจานสี 

2.Preview แสดงตัวอยางที่ของคาที่เราตั้งใน Appearance 
 
 

• เม่ือกด OK แลวจะพบกับวัตถุ 2 ชิ้น นั่นกค็ือ 1.Rollover Image และ 2.Rollover Area บนสไลดใน
ตําแหนงกลางสไลด และ จะปรากฏ Timeline ของ Rollover Area ขึ้นมา เพื่อควบคมุการนําเสนอ 
Rollover Image และ Rollover Area ซ่ึงสามารถปรับจดุเริ่มตนและจุดสิ้นสุดการนาํเสนอไดอยาง
อิสระ **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดับการนาํเสนอวัตถุบน Timeline 
หนาท่ี 6-8) ** 

1  

2 
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รูปภาพ เม่ือใสรูปภาพเขามา และถารูปใหญพอดีกับ Work Area จะทําใหมองไมเห็นวัตถุ 2 ชิ้น 

 
 
 

 
 

1.Rollover Area เปนกรอบพื้นที่ที่เราใชครอบในสวนที่เวลาใชเคอรเซอรเมาสไปวางแลวเกดิรูปภาพขึ้นมา 

2. Rollover Image เปนรูปภาพที่เราตองการใหปรากฏ 

เกิด Timeline ของ Rollover Image ขึ้นมา 

1. Rollover Area 

2. Rollover Image
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• ในที่นี้ตองการใหเวลาที่นําเคอรเซอรเมาสไปวางไวบนขอความวา “กิจกรรมดีๆ” (ใหเรา Insert > 

Text Caption เขามา) จะปรากฏรูปภาพแบนเนอรสานฝนปนรักดวยหนังสือขึ้นมาโดยอัตโนมัติ 

ขั้นตอนการทําก็คือ ใหเราคลิกเลือก Rollover Area ไปวางครอบในสวนท่ีเราตองการนั่นก็คือ

ขอความ “กิจกรรมดีๆ” ซ่ึงเราสามารถปรบั Rollover Area และ Rollover Image ใหเปนไปตาม

ความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Rollover Area และ 

Rollover Image 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิก Rollover Area และ Rollover Image 

 

 
 
 
 

• เม่ือเราเลือกรูปแบบของกรอบเนนท่ีเราตองการไดแลว เราสามารถดูตวัอยางงานได โดย กด F3 เพื่อ

แสดงสไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทัง้โปรเจ็กต  

 
 

 

กรอบสีสม คือ Rollover 

Area ท่ีนํามาคลุมขอความ 

Rollover Image คือ 

ภาพที่จะแสดงขึ้นมาเมื่อ

นําเคอรเซอรเมาสไปวาง

ไวบริเวณ Rollover 

Area ท่ีอยูบนขอความ
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3.9 การใสแอนิเมชั่น (Animation) 
 เราสามารถนําไฟลแอนิเมชัน่เขามาได 4 ชนิด 

- ไฟล Adobe Flash ที่เปน Source File โดยมีนามสกุล * .fla 
- ไฟล Adobe Flash ที่ Publish แลว โดยมนีามสกุล * .swf 
- ไฟลภาพแอนิเมชั่นเล็กๆ อยาง GIF โดยมีนามสกุล *.gif 
- ไฟลวดีีโอ โดยมีนามสกุล *.avi 

 

• ท่ีเคร่ืองมือ Object ใหคลิกเลือกไอคอน Animation หรือ Insert >  Animation 
 

     หรือ     
 

 

 

 

 

 

คลิกท่ี Animation

Insert > Animation
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• เม่ือเราเลือก Animation แลวจะเกิดหนาตาง Open เพื่อใหเราเลือกไฟลแอนิเมชั่นท่ีเราตองการ

นําเขามาใชงาน ซ่ึงถาเราเลือกไฟลท่ีเราตองการแลวใหกด Open 

 

 

• เม่ือกด Open แลวจะเกิดหนาตาง New Animation โดยมกีารแสดงการเคลื่อนไหวของไฟล 

แอนิเมชั่นท่ีเรานําเขามา  
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>> สวนประกอบของหนาตาง Animation มีดังนี ้

แถบที่ 1 Animation  
 

 
 
1.กรอบ แสดงภาพแอนิเมชัน่ที่เรานําเขาไป 

2.Statistics แสดงรายละเอียดของไฟลแอนิเมชั่นที่นําเขามา 

3.Appearance คือ กําหนดความโปรงใสของแอนิช่ัน โดยเราสามารถกําหนดคาไดตั้งแต 0-100 โดย 

 ปุม Library… คลิกเพื่อเลือกไฟลแอนิเมชั่นใหมจากไลบารี่ 

 ปุม Import… คลิกเพื่อเลือกไฟลแอนิเมชัน่ใหมจากภายนอก 

** รายละเอียดของ แถบ Option, Audio และ Size and Position สวนประกอบจะเหมือนกับ Text Animation  

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 13-16) ** 

จุดท่ีแตกตาง คือ 

-หนาตาง Animation แถบที่ 2  Option > Display for จะมี Synchronize with Project คือ การบีบอัดไฟล

แอนิเมชั่นเขาไปในลงิคงาน 

-หนาตาง Animation  แถบที่ 2  Option จะไมมี Loop 

1  
2 

3 
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• เม่ือกด OK แลวจะได Animation บนสไลดในตาํแหนงกลางสไลด และจะปรากฏ Timeline ของ 

Animation ขึ้นมา เพื่อควบคุมการนําเสนอ Animation ซ่ึงสามารถปรบัจุดเริ่มตนและจุดสิ้นสุด

การนําเสนอไดอยางอิสระ  **(สามารถดูรายละเอียดเพิ่มเติมไดท่ี เร่ือง การปรับลําดับการนําเสนอ

วัตถุบน Timeline หนาท่ี 6-8) ** 

 

 

 

 

• เราสามารถปรบั Animation ใหเปนไปตามความตองการ 

- ถาตองการปรับขนาดยอ-ขยายหรือยายตาํแหนง > ใชเมาสคลิกท่ี Animation  

- ถาตองการแกไขเกี่ยวกับคณุสมบัติตางๆ > กดดับเบิ้ลคลิกท่ี Animation 

 

• เราสามารถดูตวัอยางงานได โดย กด F3 เพื่อแสดงสไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้ง

โปรเจ็กต  

เกิด Timeline ของ Animation ขึ้นมา Animation บนสไลด 
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การสรางโครงงาน(Project) จาก Microsoft PowerPoint 
ในโปรแกรม Adobe Captivate 3 

 

การสรางโครงงาน(Project) จาก Microsoft PowerPoint 

 ปจจุบันคนนิยมและคุนเคยกบัการใชงานสไลดที่ทําจากโปรแกรม Microsoft PowerPoint ซ่ึงเรา

สามารถนํางานที่สรางจากโปรแกรมนี้เขามาสูโปรแกรม Adobe Captivate ได ซ่ึงสามารถนําเขาจาก 

Microsoft PowerPoint 97-2003 ที่มีนามสกุล *.ppt  

 

• เปดโปรแกรม Adobe Captivate > Record or create a new project  > Import from Microsoft 

PowerPoint กด OK 
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• เม่ือกด OK แลวจะปรากฏหนาตาง Open ขึ้นมาเพื่อใหเราไดนําไฟลงาน Microsoft PowerPoint 

เขามา ซ่ึงถาเราเลือกไฟลงานไดแลวใหกด Open 

 

 

• เม่ือกด Open แลว โปรแกรม Adobe Captivate จะจัดการกับไฟลของ Microsoft PowerPoint ดัง

รูป 

 

 

• เม่ือโปรแกรม Adobe Captivate ทําการแปลงไฟล (Convert) Microsoft PowerPoint เปนท่ี

เรียบรอยแลว จะปรากฏหนาตาง Convert PowerPoint Presentations ขึ้นมา ซ่ึงมีความสําคัญเปน

อยางมาก เพื่อท่ีจะจัดการในสวนตางๆ ดงันี้ 

กด Open
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-Name คือ ช่ือโครงงาน (Project) 

-Width / Height คือ สวนใชกําหนดขนาดของโครงงาน (Project) หรือสามารถเลือกขนาดสําเรจ็รูป

ที่โปรแกรมตั้งไวไดที่ Preset Sizes 

- Slides Preview คือ สวนของการเลือกแผนสไลด วาตองการสไลดใชแผนใดบาง ถาตองการก็ให

คลิกเลือก ซ่ึงก็จะมเีครื่องหมายถูกที่ดานหนา  แตถาไมตองการใหเอาเครื่องหมายถกูออกที่  

- Import slides as คือ การเลือกแบบนําเขาของ Microsoft PowerPoint   

 Animation - การใชงาน Microsoft PowerPoint  เปนพื้นหลังของพรอมกับการเคลื่อนไหว

ที่ไดสรางไว 

Background image - การใชงาน Microsoft PowerPoint  โดยแปลงใหเปนพื้นหลังของ

สไลด  
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-Advance slide คือ หลักการนําเสนอการเคลื่อนไหว มี 2 รูปแบบ คือ 

 On mouse click - ใชเมาสคลิกเพื่อควบคุม 

 Automatically – การนําเสนอแบบอัตโนมตัิ 

 

• เม่ือเราตั้งคาตางๆ ตามความตองการเรียบรอยแลวใหเรากด OK จะไดหนาตาง ตัวอยาง ดงัรูป 

รูปภาพ ตัวอยางการ Import slides as แบบ Background image 

 

** เราสามารถแทรก Microsoft PowerPoint ในโครงงาน ได โดยไปทีเ่มนูบาร Insert > Slide > 

PowerPoint Slide… ตัวอยาง ดงัรูป 
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การสรางโครงงาน(Project) แบบสไลดโชว 
ในโปรแกรม Adobe Captivate 3 

 

การสรางโครงงาน(Project) แบบสไลดโชว 

เปนการนําไฟลภาพเขามาจดัเรียงแลวมีการนําเสนอแบบเคลื่อนไหวอยางงายๆ  

• เปดโปรแกรม Adobe Captivate > Record or create a new project  > Image Project กด OK 

 

 

• เม่ือกด OK แลวจะปรากฏหนาตาง Image Project เพื่อท่ีจะจัดการในสวนตางๆ ดงันี้  
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User defined (custom) การตั้งคาดวยตนเอง 

-Width / Height คือ สวนใชกําหนดขนาดของโครงงาน (Project) หรือสามารถ 

- Preset Sizes คือ ขนาดสําเร็จรูปที่โปรแกรมตั้งไว 

 

• เม่ือเราเลือกหรือกําหนดขนาดของชิ้นงานไดตามความตองการเรียบรอยแลวใหเรากด Browse… 

เพื่อทําการเปดหาภาพที่เราไดจัดเตรียมไวในการทําสไลดโชว หนาตาง Open จะปรากฏขึ้นมา

ตัวอยาง ดงัรูป 

 
 

• เม่ือกด Open แลว โปรแกรม Adobe Captivate จะจัดการกับไฟลของ Image ดังรูป 
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• เม่ือโปรแกรม Adobe Captivate จัดการกับไฟลเรียบรอยแลว จะปรากฏหนาตาง ดังรูป 

 

 

** เราสามารถแทรก Image ในโครงงาน ได โดยไปท่ีเมนูบาร Insert > Slide > Image Slide… ตัวอยาง 

ดังรปู ** 

 

 
 
 
 



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          64 

การสรางแบบทดสอบ (Quiz) 
ในโปรแกรม Adobe Captivate 3 

 

ในการกําหนดเงื่อนไขแบบทดสอบนี้ เราจําเปนที่จะตองกาํหนดไวตั้งแตเร่ิมตน เพราะสิ่งตางๆ ที่

เรากําหนดนี้มคีวามเกีย่วของกับการทําแบบทดสอบ การสอบได สอบตก ไปจนถึงมาตรฐานการจดัทําสื่อ

การเรียนรูอยาง SCORM 1.2 , SCORM 2004 หรือ AICC 

นอกจากนั้นเรายังสามารถกําหนดสิ่งตางๆ ที่ปรากฏในขณะที่ทําแบบทดสอบใหเปนภาษาไทย โดย

มีรายละเอียดในสวนตางๆ ดงันี้  

 

• ท่ีเมนูบาร เลือกท่ี Quiz > Quiz Preferences… 
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• เกิดหนาตาง Preferences ใหเราดูในสวนของ Quiz 

 

ในสวนของ Quiz ที่เราเห็น จะมีเมนยูอยๆ อยู 5 สวนดวยกัน 

1.Reporting 

2.Settings 

3.Pass and Fail 

4.Defult Labels 

5.PENS 

 

ในคูมือเลมนี้จะใหตั้งคาใน 3 สวน คือ Settings , Pass and Fail และ  Defult Labels 

Settings 

เปนการกําหนดคาขอมูลใหกับแบบทดสอบของเรา  
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1.Quiz 

- Name คือ การกําหนดชื่อของ project  

- Required คือ การกําหนดการทําแบบทดสอบ คือ 

 

Optional - the user can skip this quiz คือ แบบที่ผูเรียนสามารถขามแบบทดสอบได 

Required - the user must take the quiz to continue คือ แบบที่ผูเรียนตองทํา

แบบทดสอบกอนถึงจะสามารถไปตอได 

Pass required - the user must pass the quiz to continue คือ แบบที่ผูเรียนสามารถตอง

ทําแบบทดสอบในหนานั้นๆ ใหผานกอนถึงจะสามารถไปตอได 

Answer all - the user must answer every question to continue คือ แบบที่ผูเรียนตองทํา

แบบขอสอบใหครบทุกขอเสียกอน จึงจะสามารถสงขอสอบได 

1 

2 
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- Objective ID คือ หมายเลขกํากับประจําสไลด 

- Interactive ID Prefix คือ การกําหนดตั้งชื่อหนาแสดงผลที่กําหนดใหเปนสวน Interactive 

2.Setting สําหรับใชแสดงขอความเงื่อนไขโตตอบผูใชงาน มี 5 option คือ 

- Shuffle Answers  คือ เงื่อนไขในการสลับคําตอบ 

- Allow backward movement คือ สามารถยอนกลับได 

- Allow user to review quiz คือ การเรียกเพื่อแสดงขอมลูผลการทําแบบทดสอบในตอนทาย ซ่ึงจะ

มีเงื่อนไขตามมาคือ Question Review Messages... (ซ่ึงเมื่อคลิกเขาไป เราสามารถปรับเปลี่ยนขอความ

โตตอบผูใชงานใหเปนไปตามความตองการของเราได) ตัวอยางดังรูป 
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รูปภาพ ตัวอยางการปรับเปล่ียนขอความใน Question Review Messages 

 

- Show score at end of quiz คือ แสดงผลคะแนนเมื่อจบแบบทดสอบ ซ่ึงจะมีเงื่อนไขตามมาคือ Quiz 

Result Messages (ซ่ึงเมื่อคลิกเขาไป เราสามารถปรับเปลี่ยนขอความโตตอบผูใชงานใหเปนไปตามความ

ตองการของเราได) ตัวอยางดังรูป 
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รูปภาพ ตัวอยางการปรับเปล่ียนขอความใน Quiz Result Messages 
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- Show progress คือ การแสดงความกาวหนาในการทํากจิกรรมแบบทดสอบ 

 

Pass and Fail  

เปนสวนกําหนดเงื่อนไขผลการทําแบบทดสอบรวมทั้งหมด นี้ มีอยู 3 สวนคือ 

 

 

  

1.Pass/Fail options เปนสวนกําหนดเงื่อนไขการทดสอบวาให ผาน หรือ ไมผานมีทั้งแบบ

กําหนดคาเปอรเซนต หรือกาํหนดคะแนนที่ผานการทดสอบ 

2.If passing grade เปนการกําหนดวา ถาผูใชทําแบบทดสอบผานจะใหเกิดอะไรตอไป โดยเรา

สามารถคลิกเลือกไดที่ Action  

  3.If failing grade เปนการกาํหนดวา ถาผูใชทําแบบทดสอบไมผานจะใหเกิดอะไรตอไป โดยเรา

สามารถคลิกเลือกไดที่ Action 

1 

2 

3 
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- Allow User  คือ เปนการกาํหนดจํานวนครั้งของการตอบผิด 

- ในสวนของ Infinite attempts ถาเราคลิกเลือกในสวนนี้ คาตรงสวน allow User และ Action จะ

ถูก Disable ทันที เพราะสามารถทําขอสอบผิดกี่คร้ังก็ไดแบบไมมีกําหนด 

  

Default Labels 

เปนสวนกําหนดขอความของปุม และขอความแสดงโตตอบกับผูเรียน มีอยู 2 สวน คอื 

 

 

 

1.Default question button labels คือ สวนกําหนดขอความประจําปุมในหนาขอสอบ ตัวอยาง ดัง

รูป 

2.Default question feedback คือ สวนขอความแสดงระหวางการทําแบบทดสอบ ตัวอยาง ดังรูป 

1 

2 
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รูปภาพ ตัวอยางการปรับเปล่ียนขอความใน Default question button labels 

 

1.การสรางแบบทดสอบ 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… 

 

Insert > Slides > Question Slide…
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• เม่ือเราเลือก Question Slide… แลวจะเกิดหนาตาง Question Type ดังรูป 

 

 

จะมีรูปแบบของแบบทดสอบใหเราเลือกทัง้หมด 8 แบบ คือ 

1.Multiple choice คือ การทําขอสอบปรนัย  

2.True/False คือ ขอสอบแบบเลือกตอบถูกหรือผิด 

3.Fill-in-the-blank คือ ขอสอบแบบเติมคําในชองวาง 

4.Short answer คือ ขอสอบแบบตอบคําถามสั้น ๆ 

5.Matching คือ ขอสอบแบบจับคู 

6.Hot Spot  คือ ขอสอบแบบกําหนดบริเวณ 

7.Sequence คือ ขอสอบแบบเรียงลําดับ 

8.Rating Scale (Likert) คือ แบบสํารวจเพือ่ตรวจสอบความนยิม 
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ในคูมือเลมนี้จะขอกลาวถึงการทําขอสอบเพียง 7 แบบ คอื 

 

1.Multiple choice คือ การทําขอสอบปรนยั 

• ใหเราคลิกเลือกท่ี Multiple choice และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสราง

แบบทดสอบ และมีการใหคะแนน (ถาเราเลือก Survey Question… จะเปนการสรางแบบสํารวจ จะ

ไมมีคะแนนใหสําหรับแบบทดสอบนั้นๆ ) 

 

 

 

 

• เม่ือเราเลือก Multiple choice แลวจะเกิดหนาตาง Multiple choice Question ดังรปู 

 

Multiple choice 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 
 

มีอยู 2 สวน หลักๆ คือ  

1. Questions สวนของคําถาม 

2 

1 
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 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Question - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

2. Answers สวนของคําตอบ  

- การเพิ่มคําตอบ สามารถทําได 2 แบบ คอื 

1.คลิกแลวพิมพเขาไปยังบริเวณทีว่างๆ 

2.คลิกที่ปุม Add 

  - การลบคําตอบ 

ทําไดโดยเลือกขอที่เราตองการลบ จากนัน้คลิกที่ปุม Delete 

  - การกําหนดขอท่ีถูกตอง 

ใหเราคลิกที่ปุมที่อยูดานหนาของคําตอบที่ถูกตอง  

  - Type คือ รูปแบบของการตอบมี  2 แบบ คือ 

1.Multiple Responses คือ การเลือกใหมีขอถูกมากกวา 1 ขอ ปุมของหนา

คําตอบจะเปน  

2.Single Responses  คือ การเลือกใหมีขอถูกเพียง 1 ขอ ปุมของหนาคําตอบ

จะเปน  

  - Numbering คือ รูปแบบของคํานําหนาคําตอบ 

1. เปนตัวเลข คือ 1, 2 , 3… 

2. เปนตัวอักษรภาษาอังกฤษ คือ a , b , c... และ A , B , C… 
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2. แถบ Options ใชในการกาํหนดคณุสมบัติตางๆ เพิ่มขึ้น ไมวาจะเปนการกําหนดใหผูเรียนสามารถตอบได

กี่คร้ัง ถาตอบถูก-ผิดจะใหทาํอะไรตอไป ดังรูป 

 

 

มีอยู 3 สวน หลักๆ คือ  

1.Type คือ รูปแบบของการสรางแบบทดสอบ มี 2 หัวขอใหเลือก คอื 

1.1 Graded - there are right and wrong answers คือ การกําหนดใหมีคําตอบที่ถูก-ผิด 

ซ่ึงถาเลือกในสวนนี้มี จะมสีวนกําหนดใหแสดงปุมของหนาแบบทดสอบทั้ง 3 ปุม คือ 

clear (ยกเลิก), back (ถอยกลับ) และ skip (ขามถัดไป)  

1.2 Survey – there are no wrong answer คือ การไมใหมีคําตอบผิด 

2. If Correct answer  เปนสวนกําหนดเงือ่นไขของหนาแบบทดสอบวาจะใหดําเนนิการตอไป

อยางไร ถาผูใชทําแบบทดสอบถูกตอง ซ่ึงเปนสวนกําหนดใหโปรแกรมแสดง Response feedback ที่เปน

ขอความ กลับมาสูผูใชงานตามที่ตั้งคาไว โดยมี Actionใหเลือกดังนี้ คอื 

- Continue      ใหนําเสนอเนือ้หาตอไป 
- Go to previous slide   ถอยกลับสไลดกอนหนา 

1 

2 

3 
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- Go to next slide  ไปสไลดถัดไป 
- Jump to slide    เล่ือนไปสไลดที่ระบุ 
- Open URL or file   เปดไฟลหรือเว็บไซต 
- Open other project  เปดโครงงานอื่นๆ 
- Send e-mail to   สงอีเมล 
- Execute JavaScript    เรียกใชงาน JavaScript 

 ถาเราเลือก Show correct message จะปรากฏกรอบขอความบอกวาคําตอบที่เลือกเปนคาํตอบที่
ถูกตอง (ตามที่ตั้งคาไว) 
 

3. If wrong answer เปนการกําหนดเงื่อนไขในกรณีผูใชทําแบบทดสอบผิด  
- Allow User  คือ เปนการกาํหนดจํานวนครั้งของการตอบผิด ซ่ึงถาเราใหผูใชตอบอยางไม

จํากัดจาํนวนครั้งใหเลือกในสวนของ Infinite attempts ซ่ึงถาเราคลิกเลือกในสวนนี้ คาตรงสวน 

Allow User และ Action จะถูก Disable ทันที 

- Failure level คือ การกําหนดลําดับชั้นในการตอบผิด ซ่ึงจะแสดงเงือ่นไข 4 ระดับ (none 
และระดับ 1-3)  

- Action คือ การกําหนดเงื่อนไขของหนาแบบทดสอบวาจะใหดําเนินการตอไปอยางไร ถา

ผูใชทําแบบทดสอบผิด โดยมีใหเลือกดงันี ้คือ 

- Continue      ใหนําเสนอเนือ้หาตอไป 

- Go to previous slide   ถอยกลับสไลดกอนหนา 

- Go to next slide  ไปสไลดถัดไป 

- Jump to slide    เล่ือนไปสไลดที่ระบุ 

- Open URL or file   เปดไฟลหรือเว็บไซต 

- Open other project  เปดโครงงานอื่นๆ 

- Send e-mail to   สงอีเมล 

- Execute JavaScript    เรียกใชงาน JavaScript 

ถาเราเลือก Show retry message จะปรากฏกรอบขอความบอกวาใหเราลองใหมอีกครัง้ (ตามที่ตั้งคา
ไว) 
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ถาเราเลือก Show incomplete message จะเปนสวนแสดงขอความหากผูใชยังทํางานไมครบถวน 
(ตามที่ตั้งคาไว) 
 
 
3.แถบ Reporting เปนแถบทีใ่ชในการรายงาน หรือ สงคาคําตอบของแบบทดสอบไปสูระบบ LMS ดังรูป 
 
 

 

 

มีอยู 2 สวน หลักๆ คือ  

1.Report answers ใหแสดงผลการทําแบบทดสอบ และการนําออกไปสูระบบ LMS  
 - Objecttive ID คือ หมายเลขกํากับประจําสไลด 
 - Interactive ID คือ การกําหนดตั้งชื่อหนาแสดงผลที่กําหนดใหเปนสวน Interactive 
2. Setting กําหนดเวลาในการทําแบบทดสอบ หากตองการใหมกีารกาํหนดเวลาใหเลือกที่ Time 

limit แลวกําหนดเวลาลงไป 
 

 

• หลังจากนั้นใหเราตั้งคาตางๆ ของ Multiple Choice Question ตามความตองการและใสคําถาม-
คําตอบ และกด OK ตัวอยาง ดงัรูป 
   

1 

2 
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รูปภาพ ตัวอยางการใสคําถาม-คําตอบลงไปใน Multiple Choice 

 

 

• เม่ือกด OK แลวจะไดแบบทดสอบ Multiple choice เขามาในโครงงาน (Project) ของเรา  

เราสามารถจัดวางไดตามปกติ  

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question… 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   
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• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

2.True/False คือ ขอสอบแบบเลือกตอบถูกหรือผิด 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี True/False 

และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการใหคะแนน (ถาเรา

เลือก Survey Question… จะเปนการสรางแบบสํารวจ จะไมมีคะแนนใหสําหรับแบบทดสอบนั้นๆ ) 

Edit Question…
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• เม่ือเราเลือก True/False แลวจะเกิดหนาตาง True/False Question ดังรูป 

 

 

True/False 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีอยู 2 สวน หลักๆ คือ  

1. Questions สวนของคําถาม 

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Question - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

2. Answers สวนของคําตอบ โปรแกรมจะกําหนดมาใหเลยแค 2 ขอ คือ ถูกและผิด 

- Type คือ รูปแบบของการตอบมี  2 แบบ คือ 

1.True / False 

2.Yes/No 

 

2 

1 
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  - การกําหนดขอท่ีถูกตอง 

ใหเราคลิกที่ปุม  ที่อยูดานหนาของคําตอบที่ถูกตอง  

  - Numbering คือ รูปแบบของคํานําหนาคําตอบ 

1. เปนตัวเลข คือ 1, 2 , 3… 

2. เปนตัวอักษรภาษาอังกฤษ คือ a , b , c... และ A , B , C 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 

 

• หลังจากนั้นใหเราตั้งคาตางๆ ของ True/False Question ตามความตองการและใสคําถาม-คําตอบ 
และกด OK ตวัอยาง ดงัรปู 
   

 

รูปภาพ ตัวอยางการใสคําถาม-ตอบลงไปใน True/False 
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• เม่ือกด OK แลวจะไดแบบทดสอบ True/False เขามาในโครงงาน (Project) ของเรา เราสามารถจัด

วางตาํแหนงไดตามปกติ  

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question… 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   

 

 

 

• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

3.Fill-in-the-blank คือ ขอสอบแบบเติมคําในชองวาง 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี Fill-in-the-

blank และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการใหคะแนน 

(ถาเราเลือก Survey Question… จะเปนการสรางแบบสาํรวจ จะไมมีคะแนนใหสําหรับ

แบบทดสอบนัน้ๆ ) 
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• เม่ือเราเลือก Fill-in-the-blank แลวจะเกิดหนาตาง New Fill-in-the-blank Question ดังรปู 

 

Fill-in-the-blank 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีอยู 2 สวน หลักๆ คือ  

1. Questions  

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Description - ใหกรอกคําถามของแบบทดสอบ หรือ ขอความบรรยายถึงแบบทดสอบ  

 Points -ใหกรอกจํานวนคะแนน  

2. Type in the question or phrase that needs to be completed ในสวนนีเ้ปนการกาํหนดสวนที่

จะหายไปเพื่อใหเติมคําลงในชองวางใหกบัแบบทดสอบของเรา คือ  

Phrase - ใชสําหรับพิมพคําถามพรอมกับคําตอบลงไป จากนั้นคอยปายดําขอความทีเ่รา

ตองการใหเปนคําตอบ เสรจ็แลวกดปุม Add Blank… จากนั้นก็จะเกิดหนาตาง Blank Answer 

ตัวอยาง ดังรูป 

2 

1 
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ซ่ึงจะมีตัวเลือกมาใหเราเลือก 2 แบบ คือ 

1. The user will type in the answer, which will be compared to the list below. 

- การใหผูใชตอบโดยการเตมิคําลงในชองวางดวยการพมิพดวยตนเอง ซ่ึงสามารถเพิ่ม

คําตอบใหหลายหลายได ตัวอยาง ดังรูป 

 

กด Add Blank…
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2. The user will select and answer from the list below. -  เปนการสรางตัวเลือก

ของคําตอบขึ้นมาใหแบบ Drop down list ซ่ึงจะมีรูป  หนาคําตอบ เพือ่ใหเลือก ตวัอยาง 

ดังรูป 

 

 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 

 

• หลังจากนั้นใหเราตั้งคาตางๆ ของ Fill-in-the-blank Question ตามความตองการและใสคําถาม-
คําตอบ และกด OK ตัวอยาง ดงัรูป 
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รูปภาพ ตัวอยางการใสคําถาม-ตอบลงไปใน Fill-in-the-blank 

 

• เม่ือกด OK แลวจะไดแบบทดสอบ Fill-in-the-blank เขามาในโครงงาน (Project) ของเรา  

เราสามารถจัดวางตาํแหนงไดตามปกต ิ

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question… 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   
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• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

4.Short answer คือ ขอสอบแบบตอบคาํถามสั้นๆ 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี Short 

answer และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการให

คะแนน (ถาเราเลือก Survey Question… จะเปนการสรางแบบสาํรวจ จะไมมีคะแนนใหสําหรับ

แบบทดสอบนัน้ๆ ) 
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• เม่ือเราเลือก Short answer แลวจะเกิดหนาตาง New Short answer Question ดังรปู 

 

Short answer 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีอยู 2 สวน หลักๆ คือ  

1. Questions  

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Description - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

2. Acceptable Answer คือ การใหผูใชตอบโดยการเติมคําลงในชองวางดวยการพิมพดวยตนเอง ซ่ึง

สามารถเพิ่มคําตอบใหหลากหลายได เพื่อเปนทางเลือกใหกับผูใชแบบทดสอบ 

- การเพิ่มคําตอบ สามารถทําได 2 แบบ คอื 

1.คลิกแลวพิมพเขาไปยังบริเวณทีว่างๆ 

2.คลิกที่ปุม Add 

2 

1 
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  - การลบคําตอบ 

ทําไดโดยเลือกขอที่เราตองการลบ จากนัน้คลิกที่ปุม Delete 

- The answer is case-sensitive ถาเราเลือกจะมีผลกับคําตอบที่เปนภาษาอังกฤษเทานั้น 

โดยจะถือวาตวัพิมพใหญและพิมพเล็ก มีคาตางกัน 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 

 

• หลังจากนั้นใหเราตั้งคาตางๆ ของ Short-Answer Question ตามความตองการและใสคําถาม-
คําตอบ และกด OK ตัวอยาง ดงัรูป 
   

 
รูปภาพ ตัวอยางการใสคําถาม-ตอบลงไปใน Short answer 
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• เม่ือกด OK แลวจะไดแบบทดสอบ Short answer เขามาในโครงงาน (Project) ของเรา เราสามารถ

จัดวางตําแหนงไดตามปกต ิ

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question… 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   

 

 

 

• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

5.Matching คอื ขอสอบแบบจับคู 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี Matching 

และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการใหคะแนน (ถาเรา

เลือก Survey Question… จะเปนการสรางแบบสํารวจ จะไมมีคะแนนใหสําหรับแบบทดสอบนั้นๆ ) 
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• เม่ือเราเลือก Matching แลวจะเกิดหนาตาง  New Matching Question ดังรปู 

 

Matching 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีอยู 2 สวน หลักๆ คือ  

1. Questions สวนของคําถาม 

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Question - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

2. Answers สวนของคําตอบ  

- คอลัมน จะแบงเปน 2 คอลัมน (เราสามารถแกไขคําวา Column 1 และ Column 2 เปน

ขอความอื่นๆ ได) 

2 

1 
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คอลัมนซาย (Column 1) คือ ใชในการกําหนดคําตอบแรก ซ่ึงจะมีรูปสี่เหล่ียมอยู

ดานหนาคําตอบในคอลัมนนีเ้พื่อแสดงใหเห็นถึงคําตอบ

ที่ถูกจับคูดวย หรือ แสดง Numbering ของคอลัมนขวา 

(Column 2) ตัวอยาง ดังรูป 

 
รูปภาพ ตัวอยางการแสดงของคอลัมนซาย (Column 1) 

 

คอลัมนขวา (Column 2) คือ ใชในการกําหนดสวนของคําตอบที่ 2 ซ่ึงสวนนี้เปน 

สวนที่ตองนําไปจับคูกับคําตอบแรก ซ่ึงจะมี Numbering 

อยูดานหนาคําตอบ เพื่อไปแสดงที่รูปสี่เหล่ียมที่ คอลัมน

ซาย (Column 1) ตัวอยาง ดังรูป 

 
รูปภาพ ตัวอยางการแสดงของคอลัมนขวา (Column2) 

 

- การเพิ่มคําตอบ คอลัมนซาย (Column 1)  และ คอลัมนขวา (Column 2) สามารถทําได 2 

แบบ คือ 

1.คลิกแลวพิมพเขาไปยังบริเวณทีว่างๆ 

2.คลิกที่ปุม Add 

  - การลบคําตอบ 

ทําไดโดยเลือกขอที่เราตองการลบ จากนัน้คลิกที่ปุม Delete   
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  - วิธีการจับคู 

เมื่อเราเติมคําตอบลงไปทั้ง 2 คอลัมนสมบูรณแลว ใหเราลากคําตอบจากคอลัมน

ซาย (Column 1)  มาใสในคอลัมนขวา (Column 2) หรือ จากคอลัมนขวา (Column 2) มาใส

ในคอลัมนซาย (Column 1)  ก็ได ซ่ึงถาเราจับคูแลวจะมีเสนตรงโยงระหวางคําตอบทีถู่ก

เขาหากัน พรอมกับโชว Numbering ดานหนาคอลัมนซาย (Column 1) อีกดวย  ตัวอยาง ดัง

รูป 

 

รูปภาพ ตัวอยางการใสคําตอบ และแสดงการจับคูระหวาง Column 1 และ Column 2  ใน Matching 

 

- Style คือ รูปแบบของการตอบมี  2 แบบ คือ 

1.Drag Drop คือ การใชเมาสลากแลววาง 

2.Drop Down List  คือ การคลิกเมาสเลือกรายการที่กําหนดไว 

  - Numbering คือ รูปแบบของคํานําหนาคําตอบ 

1. เปนตัวเลข คือ 1, 2 , 3… 

2. เปนตัวอักษรภาษาอังกฤษ คือ a , b , c... และ A , B , C… 

 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 
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• หลังจากนั้นใหเราตั้งคาตางๆ ของ Matching Question ตามความตองการและใสคําถาม-คําตอบ 
และกด OK ตวัอยาง ดงัรปู 
   

 

รูปภาพ ตัวอยางการใสคําถาม-ตอบลงไปใน Matching 

 

• เม่ือกด OK แลวจะไดแบบทดสอบ Matching เขามาในโครงงาน (Project) ของเรา เราสามารถจัด

วางตาํแหนงไดตามปกต ิ

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question…  

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   
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• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

6.Hot Spot  คือ ขอสอบแบบกําหนดบริเวณ 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี Hot Spot  

และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการใหคะแนน (ถาเรา

เลือก Survey Question… จะเปนการสรางแบบสํารวจ จะไมมีคะแนนใหสําหรับแบบทดสอบนั้นๆ ) 
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• เม่ือเราเลือก Hot Spot  แลวจะเกิดหนาตาง Hot Spot Question ดังรูป 

 
 

Hot Spot   

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีสวนหลักๆ คือ  

Questions สวนของคําถาม 

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Question - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

 Hot Spot - จํานวนของตําแหนงที่ตองการใหม ี

Choose - กด Select เพื่อเลือกรูปแบบของภาพเคลื่อนไหวเมื่อมีการคลกิเลือก ตัวอยาง ดัง

รูป 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 
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• หลังจากนั้นใหเราตั้งคาตางๆ ของ Hot Spot  Question ตามความตองการและใสคําถามและจุด Hot 
Spot ลงไปและกด OK ตัวอยาง ดังรปู 
   

  

รูปภาพ ตัวอยางการใสคําถาม-และจุด Hot Spot ลงไปใน Hot Spot  

 

• เม่ือกด OK แลวจะไดแบบทดสอบ Hot Spot เขามาในโครงงาน (Project) ของเรา เราสามารถจัด

วางตาํแหนงไดตามปกต ิ และเราควรจัดวางหรือยอ-ขยายพื้นท่ีของ Hot Spot  

ไปยงัตาํแหนงท่ีเราตองการตามความเหมาะสม ซ่ึงในตัวอยางนี้ถามวา “ภาพใดคือโลโกของมูลนิธิ

อินเทอรเน็ตรวมพัฒนาไทย?” เพราะฉะนั้น Hot Spot ก็ควรลากไปครอบรูปภาพที่เปนโลโกของ

มูลนิธิอินเทอรเน็ตรวมพัฒนาไทย 

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question…  

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   
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• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

7. Sequence คือ ขอสอบแบบเรียงลําดับ 

• ท่ีเมนูบาร > Insert > Slides > Question Slide… > Question Type ใหเราคลิกเลือกท่ี Sequence 

และหลังจากนั้นใหคลิกปุม Graded Question… เพื่อสรางแบบทดสอบ และมีการใหคะแนน (ถาเรา

เลือก Survey Question… จะเปนการสรางแบบสํารวจ จะไมมีคะแนนใหสําหรับแบบทดสอบนั้นๆ ) 
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• เม่ือเราเลือก Sequence แลวจะเกิดหนาตาง Sequence Question ดังรปู 

 

Sequence 

Graded Question…
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จะมีหนาตางเพื่อใหเรากาํหนดคาตางๆ จํานวน 3 แถบ ซ่ึงมีรายละเอียด ดังนี ้

1. แถบ Questions ใชในการตั้งคําถาม คําตอบ คะแนน ดังรูป 

 

 

มีอยู 2 สวน หลักๆ คือ  

1. Questions  

 Name - ใหกรอกชื่อของแบบทดสอบลงไป (สามารถปลอยวางได) 

 Description - ใหกรอกคําถามของแบบทดสอบ 

 Points -ใหกรอกจํานวนคะแนน  

2. Answer ใหเรากรอกคําตอบที่มีการเรียงลําดับอยางถูกตองลงไป 

- การเพิ่มคําตอบ สามารถทําได 2 แบบ คอื 

1.คลิกแลวพิมพเขาไปยังบริเวณทีว่างๆ 

2.คลิกที่ปุม Add 

2 

1 
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  - การลบคําตอบ 

ทําไดโดยเลือกขอที่เราตองการลบ จากนัน้คลิกที่ปุม Delete 

- Style คือ รูปแบบของการตอบมี  2 แบบ คือ 

1.Drag Drop คือ การใชเมาสลากแลววาง 

2.Drop Down List  คือ การคลิกเมาสเลือกรายการที่กําหนดไว 

  - Numbering คือ รูปแบบของคํานําหนาคําตอบ 

1. เปนตัวเลข คือ 1, 2 , 3… 

2. เปนตัวอักษรภาษาอังกฤษ คือ a , b , c... และ A , B , C… 

  - การสลับตําแหนงของคําตอบ 

   1. กด Move Up เพื่อเล่ือนขึ้น 

   2. กด Move Down เพื่อเล่ือนลง 

** รายละเอียดของ แถบ Option และ Reporing สวนประกอบจะเหมือนกับ Multiple choice 

(สามารถดไูดรายละเอียดเพิ่มเติมไดท่ีหนา 77-79) ** 
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• หลังจากนั้นใหเราตั้งคาตางๆ ของ Sequence Question ตามความตองการและใสคําถามและคําตอบ
ลงไปและกด OK ตัวอยาง ดังรปู 
   

 

รูปภาพ ตัวอยางการใสคําถาม-ตอบลงไปใน Sequence 

 

• เม่ือกด OK แลวจะไดแบบทดสอบ Sequence เขามาในโครงงาน (Project) ของเรา เราสามารถจัด

วางตาํแหนงไดตามปกต ิ

- ถาตองการแกไขรายละเอียดตางๆ แบบทดสอบ > กดปุม Edit Question…  

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   
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• เราสามารถลองทําแบบทดสอบได โดยกด Publish  

 

2.การแสดงผลของแบบทดสอบ 

• ทุกคร้ังท่ีเรามี Insert Questions จะมีหนาสไลดของ Results เกิดขึ้นมาดวยเสมอ ดังรปู 

 

 

 

Edit Results… 
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การปรับแก 

- ถาตองการแกไขการแสดงผลของแบบทดสอบ > กดปุม Edit Results… ตัวอยาง ดงัรูป 

 
 

- ถาตองการแกไขเกี่ยวกับตวัอักษร > กดดบัเบิ้ลคลิกในสวนของขอความนั้นๆ   

 

• เราสามารถปรบัเปล่ียนขอความในหนา Results (หนาแสดงผลคะแนน) ตัวอยาง ดงัรูป 

 

รูปภาพ ตัวอยางการปรับเปล่ียนขอความใน Results 
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การนําไฟลเสียงมาทําเปนเสียง Background 
ในโปรแกรม Adobe Captivate 3 

 

 ถาเราตองการมีเสียงประกอบการบรรยายตลอดโครงงาน (Project) ซ่ึงเราสามารถนําไฟลเสียงที่เรา

ตองการนํามาใชเสียง Background ได  

ใหเราเลือกแผนสไลดที่ตองการเพิ่มเสียง โดยจะเหน็หนาสไลดที่เราตองการอัดเสียงบน Work Area 

• ท่ีเมนูบาร Audio  > Background Audio… 

 

• เม่ือเราเลือกแลว จะ เกิดหนาตาง Preferences > Project  
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โดยในแตละปุมมีรายละเอียดดังนี ้

 

ปุมคําสัง่ การใชงาน 

 (Play) เพื่อเลนไฟลเสียงที่เลือก 

 (Stop) เพื่อหยดุไฟลเสียงที่เลือก 

 (Delete) เพื่อลบไฟลเสียงที่เลือก 

 (Edit) เพื่อแกไขไฟลเสียงที่เลือก 

 
(Recoard New…) การนําเสียงเขามาใชงานโดย

การบันทึกเสียง 

 (Import)  การนําไฟลเสียงทีม่ีอยูเขามาใชงาน 

 

เปนกรอบที่จะแสดงรายละเอยีดของไฟลเสยีงที่

เราเลือก (ช่ือของไฟลเสียง , ระยะเวลาของไฟล

เสียง) 

 

 

(Select audio from library) การนําเสียงเขามาใช

งานโดยการการนําเสียงที่มอียูแลวใน Library 

ของชิ้นงาน หรือ โครงการ (Project) ที่เราทํา 

 (Setting) การกําหนดเงื่อนไขตางๆ ของไฟลเสียง

 
(Fade Out) การตั้งคาเวลาการใชเอฟเฟกตในการ

คอยๆ ปรากฏออกมาของเสียง 

 
(Fade in) การตั้งคาเวลาการใชเอฟเฟกตในการ

คอยๆ จางหายไปของเสียง 
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และจะมีคุณสมบัติ 3 ขอ ใหเราเลือก คือ 

-Lower background audio volume on slides with audio คือ การทําใหเสียง Background เสียงเบา

กวาเสียงบรรยายหลัก 

-Loop audio คือ การทําใหเสียง Background เลนวนไปเรื่อยๆ เมื่อจบแลวก็เร่ิมเลนใหม 

 -Stop audio at end of Project คือ การทําใหเสียง Background หยุดเลนเมื่อส้ินสุดโครงงาน 

(Project)  

 

• ใหเรากด Import… เพื่อจะนําไฟลเสียงมาทําเปนเสียง Background ซ่ึงเปนการนําไฟลเสียงเขามาใช

งาน เราสามารถนําไฟลเสียงตางๆ ท่ีไดเตรยีมไวในรปูแบบ *.wav , *. Mp3 มาใชงานไดทันที หรอืจะ

ใชไฟลเสียงท่ีทางโปรแกรม Adobe Captivate มีมาใหกวา 30 ไฟลเสียงก็ได ซ่ึงจะเกิดหนาตาง 

Import Audio ขึ้นมา ใหเราเลือกไฟลเสียงท่ีเราตองการ เม่ือเลือกไดแลวใหกด Open ดังรปู 
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เม่ือเลือกไฟล

ไดแลว Open 

เม่ือนําไฟลเสียงเขา

มาแลวใหกด OK 
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การเผยแพรสื่อดิจิทัล รูปแบบ Standalone หรือ *.exe 
ในโปรแกรม Adobe Captivate 3 

 

 เปนรูปแบบทีไ่ดรับความนยิมมากสําหรับผูที่ตองการจัดสรางระบบ  E-Learningหรือ CAI ที่ทํางาน

ผานทางซีดีเพือ่ใชในการเรียนการสอน เพราะรูปแบบไฟล .exe จดเปนไฟลที่สามารถเรียกใชงานใน

ระบบปฏิบัติการ Microsoft Windows ไดทันที โดยไมตองการโปรแกรมใดๆ มาติดตั้งในเครื่องเพือ่เปดซีดี

ของเรา  

• เปดโปรเจ็กตที่เราตองการทําเผยแพร(Publish) ขึ้นมา และไปที่เมนูมารเลือก   ก็
จะเกิดหนาตาง Publish ขึ้นมา ใหเราคลิกที่แถบ Standalone จะเกดิหนาตางของ Standalone option 
ดังรูป 

 

 

หนาตาง Publish ของ Standalone 

 

แถบ Standalone 

1

2
3 

Project Information 



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          117 

หนาตาง Publish ของ Standalone สามารถปรับแตงและแกไขสวนตางๆ ไดที่ Standalone Options ดังนี ้

1.Project Title ช่ือโครงงาน (Project) ของเรา  

2.Folder ใหเราเลือกโฟลเดอรที่เราตองการใชจัดเก็บไฟลงานที่เราเผยแพร (Publish) โดย

คลิกที่ปุม Browse… 

3.Output options  

Zip file - เมื่อทําการเผยแพร (Publish) แลว ใหทําการบีบอัดไฟลหรือไม 

Full screen - เมื่อทําการเผยแพร (Publish) ใหช้ินงานของเราแสดงแบบเต็มจอ (Full screen)  

หรือไม 

Generate autorun for CD - ใหระบบทําการสรางไฟล Autorun ใหหรือไม (เพื่อใหโครงงาน 

(Project) ของเราถูกเรียกขึ้นมาเลนโดยอัตโนมัติ เหมาะสําหรับการนําไฟลงานลง CD เพื่อให CD เป

ดเองไดโดยอัตโนมัติ) 

Flash Player Version - เปนการกําหนดเวอรช่ันของ Flash Player ในการชมไฟลของเรามีใหเรา

เลือก 7 , 8 และ9 

** Project Information เปนการตั้งคาคุณสมบัติตางๆ ของโครงงาน (Project) ซ่ึงเราสามารถตัง้คา

ไดตัง้แตเร่ิมตนทําท่ี Edit > Preferences ** 

 

• เม่ือเรากําหนดคาตางๆ เรียบรอยแลวใหคลิกท่ีปุม Publish เพื่อทําการสรางโครงงาน (Project) ท่ีเรา
จะนําไปเผยแพร 
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• เม่ือระบบดําเนินการเสร็จเรียบรอยแลว คลิกปุม Close เม่ือตองการปด หรือ คลิกท่ีปุม View 
Output เม่ือตองการชมผลงานของเรา 

 

 

 

• ตัวอยางของโครงงาน (Project) ท่ีไดทําเผยแพร (Publish) ในรูปแบบ Standalone หรือ *.exe 
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ตัวอยางการสรางสื่อดิจิทัล 1 ช้ิน แบบ Software Simulation (อยางงาย) 
ดวยโปรแกรม Adobe Captivate 3 

 
1.วิธีการสรางงานแบบ Software Simulation หรือ สรางสื่อดวยวิธีจับภาพหนาจอ (Capture movie) 

Adobe Captivate เปนโปรแกรมที่ชวยใหการสรางสื่อการเรียนการสอนในรูปแบบ interactive 

multimedia ที่ถือวาเปนการสรางสรร งานที่งาย รวดเร็วและสะดวก เสนหที่สําคัญที่นับไดวาเปนจุดเดนของ 

Adobe Captivate ก็คือ การจบัภาพหนาจอแบบเสมือนจริงหรือที่เรียกวา Simulation ที่ใหภาพแบบ Full 

motion ในทุกรายละเอียดไดเลย เหมาะสําหรับการสาธิตขั้นตอนการใชโปรแกรม (Software) คอมพิวเตอร 

กอนการสรางสื่อแบบ Software Simulation ควรมีการเตรียมการเสียกอน เพราะการสรางสื่อ แบบ 

Software Simulation นั้น เปนการบันทึกจากการดําเนินเรื่องของการแสดงผลจากหนาจอคอมพิวเตอร ที่

อาจจะดูเหมือนเปนเรื่องงายแตในความเปนจริงแลวหากไมมีการซักซอมเตรียมการไวกอน ส่ือที่ได อาจจะดู

ไมสมบูรณ หรืออาจจะขาดรายละเอียดไปในบางสวนได ซ่ึงควรมีการเตรียมการดังนี ้

1. เตรียมโปรแกรม (Software) ที่ตองการสาธิตใหเรียบรอย 

2. ควรมีการซักซอมหรือฝกฝนโปรแกรม (Software) ใหคลองแคลว 

3. เมื่อซักซอมหรือฝกฝนการใชโปรแกรม (Software) แลว ควรมีการจดรายละเอียดของขั้นตอน

ตางๆ ที่เราตองการสาธิตการใช คือ 

- ควรจดขั้นตอนที่ตองการสาธิตใหละเอยีดชัดเจน เชน 1. เปดโปรแกรม 2. สรางงาน

ใหมโดยการกด File > New 

- หากตองการแสดงหรือสาธิตเปนชวงๆ กค็วรกําหนดชวงการบันทกึไวดวย เชน ชวงที่ 

1 จะสอนการเปดโปรแกรม ชวงที่ 2 การสรางงานชิ้นใหม  

4. ถาตองการใสเสียงประกอบการสาธิตโปรแกรม (Software)  ควรมีการเตรียมไมโครโฟนและ

ตรวจสอบระบบการบันทึกใหเรียบรอย สามารถใสเสียงประกอบการสาธิตได 3 แบบ 

4.1 การใสหรืออัดเสียงบรรยายพรอมกับการประกอบการสาธติโปรแกรม (Software) 
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4.2 การอัดเสียงบรรยายหรือบันทึกเสียงสดแยกจากการประกอบการสาธิต โดยสามารถทํา

ไดหลังจากทําการสาธิตโปรแกรม (Software) เสร็จเรียบรอยแลว 

4.3 การนําไฟลเสยีงบรรยายที่เรามีหรือเตรียมไวอยูแลวเขามาแทรกในสไลดตางๆ โดย

สามารถทําไดหลังจากทําการสาธิตโปรแกรม (Software) เสร็จเรียบรอยแลว 

 

2. การสรางโครงการหรืองานชิ้นใหมดวยวิธีการจับภาพหนาจอ (New Project Software Simulation)  

** ตัวอยางคือ การสาธิตวิธีการแทรกไฟลภาพในโปรแกรม Microsoft Word  ** 

 

• คลิก Start >All Program >Adobe > Adobe Captivate 3  

หรือดับเบิ้ลคลิกท่ีไอคอน Adobe Captivate 3   และเมื่อเปดโปรแกรมแลวจะเกิดหนา

หนาจอ 
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• เลือก Record new project คลิกท่ี  Record or create a new project > Software Simulation> 

Application และกด OK เพื่อเร่ิมตนสรางงานใหม 

 
 
 

                

รูปภาพขั้นตอนการสรางงาน Software Simulation ชิ้นใหมแบบ  Application 

Record or create a new project > Software Simulation > Application กด OK 

 

สําหรับ Software Simulation มีการบันทึกหนาจอคอมพิวเตอร 3 รูปแบบ โดยมีรายละเอียด คือ 

1.Application สําหรับการบันทึก เฉพาะกรอบหนาตาง(window) ของโปรแกรมที่เลือกเปดใชงาน

(Active window) เหมาะสําหรับการสอนการใชงานโปรแกรม  

 
รูปภาพของหนาตาง Software Simulation แบบ Application  

- Select the window you’d like to record  เลือกโปรแกรมที่ตองการจะใหจับภาพหนาจอ 

กด OK 
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- Snap to fit คือ การตั้งคาใหพื้นที่จับภาพหนาจอใหพอดีกับโปรแกรมที่เราไดเลือกใน Select the 

window you’d like to record โดยจะปรากฏเสนสีแดงลอมกรอบของตัวโปรแกรมที่

เลือกไว (ซ่ึงถาเราไมไดเลือกโปรแกรมไวปุม Snap to fit จะไมขึ้นมาใหเราเลือก 

และจะไมมีกรอบสีแดงเพื่อมากําหนดพื้นทีใ่หเรา) 

-Recording คือ การบันทึกภาพหนาจอตามการกระทําทีเ่กิดขึ้น โดยมี 2 วิธี คือ 

1.Recording Mode(s) จะมี option ใหเลือกใชเพิ่มเติม 4 รูปแบบ โดยผูใชสามารถ

กําหนดเงื่อนไขเหลานี้เพิ่มเตมิได ดังนี ้

1.1 Demonstration คือ รูปแบบการอธิบายการใชงานใหกับผูเรียนไดเขาใจ

ถึงการใชงานตางๆ เพราะเปนการจับการเคลื่อนไหวตามการกระทําทีเ่กิดขึ้น โดย

โปรแกรมจะสรางการเคลื่อนที่ของเมาส (Mouse) พรอมกับสรางกลองขอความ 

(Text Caption) ใหโดยอัตโนมัติ เพื่ออธิบายการใชงานใหกับผูเรียน  

1.2 Assessment Simulation คือ รูปแบบโตตอบกับผูเรียนเพื่อใหผูเรียนได

ฝกฝนการใชงานโปรแกรมจริง โดยจะมกีารบังคับใหผูเรียนกระทําตามที่ไดบันทึก

หนาจอไว โดยในรูปแบบนีโ้ปรแกรมจะสราง Objects หรือเครื่องมือ มาใหโดย

อัตโนมัติ คือ กรอบขอความสําหรับคลิก (Click Box) ขึ้นมา ซ่ึงมีเพียงกรอบ

ส่ีเหล่ียมเพื่อกาํหนดเปนพื้นที่เพื่อระบุวา ถาคลิกในบริเวณพื้นที่ที่เรากําหนดไวนัน้

จะเกิดการตอบโตขึ้น ซ่ึงโปรแกรมจะตั้งคา Option ใหดวย คือ Failure caption 

(กลองขอความสีแดง) ใหแสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความ

ผิดพลาด เมื่อคลิกปุมผิด เชน เราสอนการบันทึกโปรแกรม Microsoft Word โดย

การคลิกเมาสตรงคําสั่ง บันทึกเปน > เอกสาร Word 97-2003 เพื่อที่จะทําการบันทึก

งาน เมื่อโปรแกรมเลนมาจนถึงชวงที่ตองคลิกเมาส โปรแกรมจะหยุดเลนจนกวาจะ

มีการคลิกเมาสที่ บันทึกเปน > เอกสาร Word 97-2003 ซ่ึงถาเราคลิกถูกตอง

โปรแกรมก็จะเลนผานไปจนกวาจะมีเหตุการณใหมเกิดขึน้ แตถาหากเราคลิกผิด ก็

จะเกิดกลองขอความสีแดงขึน้มาบอกวา Select the เอกสาร Word 97-2003 menu 

item 
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1.3 Training Simulation คือ รูปแบบนี้จะคลายกับ Assessment 

Simulation โดยเปนการโตตอบกับผูเรียน แตในรูปแบบนี้จะคลายกับการฝกอบรม 

เพราะสามารถใสคําอธิบายการใชงานตางๆ เพิ่มเติมได เพือ่ใหผูเรียนไดเรียนรู

พรอมกับฝกฝนการใชงานโปรแกรมจริง โดยในรูปแบบนี้โปรแกรมจะสราง 

Objects หรือเครื่องมือ มาใหโดยอัตโนมตัิ คือ กรอบขอความสําหรับคลิก (Click 

Box) ขึ้นมา ซ่ึงมีเพียงกรอบสี่เหล่ียมเพื่อกาํหนดเปนพื้นที่เพื่อระบุวา ถาคลิกใน

บริเวณพืน้ที่ทีเ่รากําหนดไวนั้นจะเกดิการตอบโตขึ้น ซ่ึงโปรแกรมจะตัง้คา Option 

ใหดวย คือ 1. Failure caption (กลองขอความสีแดง) ใหแสดงขอความอธิบาย 

(Text Caption) ที่บอกแสดงความผิดพลาด เมื่อคลิกปุมผิด 2. Hint caption (กลอง

ขอความสีเหลือง) ใหแสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิก

ปุม 

1.4 Custom คือ การสรางสื่อตามที่ผูสรางตองการ โดยผูสรางสามารถใส 

Objects หรือเครื่องมือตางๆ เพื่ออธิบายการใชงานไดตามควรมตองการ เชน การ

สรางการเคลื่อนที่ของเมาส (Mouse), กรอบขอความสําหรับคลิก (Click Box) 

ฯลฯ  เพราะโปรแกรมจะทําการจับภาพหนาจอตามการกระทําที่เกดิขึน้ใหเทานั้น

แตจะไมใสObjects หรือเครือ่งมือมาใหแบบอัตโนมัติเหมือนรูปแบบอืน่ๆ  

** เราสามารถเลือก Option ของ Recording Mode(s) ท้ัง 4 รูปแบบพรอมๆ กันได 

 โดยที่โปรแกรมจะแยกการบันทึกใหในแตละรูปแบบโดยอตัโนมตัิ** 

- Full Motion Recording คือ การจับภาพหนาจอในลักษณะการอัดวดีีโอ 

- Audio การบันทึกเสียงบรรยายไปพรอมกับการสาธิต โดยกอนทาํการบันทึกตองติ๊กเครื่องหมาย

ถูกดานหนา Record Narration กอน เพื่อตั้งคาในโปรแกรมวาจะมีการบนัทึกเสียงบรรยายควบคูไปดวย โดย

มี 2 วิธี คือ 1. การบันทึกเสียงผาน line in ที่มีการผสมสัญญาณเสียง 2. การบันทึกเสยีงจากไมโครโฟน  
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2. Custom size รูปแบบนี้จะคลายกับแบบ Application แตแตกตางกันที่สามารถปรับขนาดของของ 

พื้นที่การบันทกึได โดยจะมรีายละเอียด Size ขึ้นมาใหตั้งคา ซ่ึงจะปรากฏเสนสีแดงลอมกรอบไว 

 

รูปภาพของหนาตาง Software Simulation แบบ Custom 

- Size คือ การตั้งคาพื้นที่จับภาพหนาจอ โดยสามารถตั้งคาได 3 รูปแบบ 

1. การใสขนาดที่ตองการที่ Width คือ ความกวาง Height คือ ความสูง 

2. การเลือกคาจาก Preset sizes คือ ขนาดสําเร็จรูปที่โปรแกรมมีไวให โดยเราสามารถเพิ่ม

และบันทึกขนาดใหมทีเ่ราตองการเขาไปได โดยเลือกที่ Customize 

3. การปรับจากกรอบเสนสีแดงที่ลอมอยู  โดยสามารถยอ-ขยาย หรือ เคลื่อนยายไปในพื้นที่

ที่ตองการได 

 

3. Full Screen สําหรับการบันทึกเต็มทั้งหนาจอภาพ Monitor ของคอมพิวเตอรที่ปรากฏ (ทําใหไม

มีเสนสีแดงเกดิขึ้นเพราะตองบันทึกเต็มจอ) โดยในรูปแบบนี้จะรองรบัการบันทึกแบบเลือกจอแสดงผลได 2 

จอภาพ สวนในละเอียดการตั้งคาอื่นๆ  
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รูปภาพของหนาตาง Software Simulation แบบ Full Screen 

 

• เม่ือเลือก Application แลวจะเกิดหนาตางขึ้นมา ใหทําการเลือกโปรแกรมหรือไฟลงานที่ตองการ

บันทึกภาพหนาจอตามการกระทําท่ีเกิดขึ้น โดยคลิกท่ี Select the window you'd like to record โดย

ในตัวอยางที่เราจะสาธิตการใชงาน คือ วิธีการแทรกไฟลภาพในโปรแกรม Microsoft Word  

 

 

รูปภาพ หนาตางการเลือกโปรแกรมหรือไฟลงานที่ตองการบันทึกภาพหนาจอ 

 

• เม่ือเลือกโปรแกรมหรือไฟลงานที่เราตองการไดแลว ใหตัง้คาตางๆ ดงันี ้

1. Snap to fit ใหทําการคลิกท่ีปุมเพื่อเลือก เพื่อตั้งคาใหพืน้ท่ีจับภาพหนาจอใหพอดกัีบ

โปรแกรมที่เราไดเลือก 

2. Recording ใหเลือก Recording Mode(s) > Training Simulation เพื่อจับภาพหนาจอแบบ

โตตอบกับผูเรียนคลายกับการฝกอบรม 
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3. Audio ใหติ๊กเคร่ืองหมายถูกดานหนา Record Narration และเลือก Microphone เพื่อ

บันทึกเสียงบรรยายจากไมโครโฟนพรอมกับการสาธิต  

4. เม่ือตั้งคาเสร็จเรียบรอยแลว ใหคลิกท่ีปุม Record 

 

 

 

รูปภาพ หนาตางการตั้งคาตางๆ ท่ี Application 

 

การเลือกโปรแกรมหรือไฟลงานทีต่องการบันทึกภาพหนาจอ 

• เม่ือเรากด Record โปรแกรมจะปรากฏหนาตางขึ้นมาเพือ่ถามเราวาตองการตรวจสอบความ

สมบูรณของการบันทึกเสียงหรือไม  ใหคลิกท่ีปุม Yes เพื่อตรวจสอบ 

 

รูปภาพ หนาตางเพื่อถามเราวาตองการตรวจสอบความสมบูรณของการบันทึกเสียงหรือไม   

2.เลือก Training 

Simulation 

1. คลิกเลือกท่ีปุม Snap to fit  

3. ต๊ิกท่ี Record Narration 

และเลือก Microphone 
4. คลิกท่ีปุม Record  

คลิกท่ีปุม Yes 
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• เม่ือคลิกท่ีปุม Yes โปรแกรมจะเริ่มทําการตรวจสอบความสมบูรณของการบันทึกเสียงกอน โดย

สังเกตุจาก Checking Input level เปนสีแดง และเมื่อตรวจสอบความสมบูรณเสร็จแลวเปนปกติ 

Input level OK จะแสดงเปนสีเขียว 

 

     

รูปภาพ หนาตางระหวางการตรวจสอบความสมบูรณของการบันทึกเสียง  

 

• หลังจากตรวจสอบการปรับแตงระดับเสียงไมโครโฟนเสร็จ แลวคลิกท่ีปุม OK โปรแกรม Adobe 

Captivate จะเร่ิมทํางานโดยมีกรอบสีแดงลอมรอบหนาตางของโปรแกรม Microsoft Word ดัง

ภาพขางลาง 
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รูปภาพ โปรแกรม Adobe Captivate จะเร่ิมทํางานโดยมีกรอบสีแดงลอมรอบหนาตางของโปรแกรม Microsoft Word  

 

• กดปุม Record เพื่อเร่ิมการบันทึกภาพหนาจอ การสาธิตการแทรกไฟลภาพในโปรแกรม Microsoft 

Word ซ่ึงถาเรากดปุม Record ก็จะเกิดหนาตางเปนรูปไมโครโฟนพรอมตัวเลขนับถอยหลัง คือ 3 > 

2 > 1 ขึ้น เนื่องจากตรง Audio เราไดทําการติ๊กเคร่ืองหมายถูกดานหนา Record Narration และ

เลือก Microphone เพื่อบันทึกเสียงบรรยายจากไมโครโฟนพรอมกับการสาธิต ซ่ึงถาเราไมเลือกก็จะ

ไมขึ้นหนาตางนี้ 

 

                             

รูปภาพ หนาตางเปนรูปไมโครโฟนพรอมตัวเลขนับถอยหลัง คือ 3 > 2 > 1  

 

 

คลิกท่ีปุม Record เพื่อเร่ิมการบันทึก 
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• หลังจากกดปุม Record แลว ใหเราเริ่มสาธิตการแทรกไฟลภาพในโปรแกรม Microsoft Word และ

เม่ือเราสาธิตเสร็จแลว ใหเรายกเลิกหรือหยุดการบันทึก โดยการกดปุม End บนแปนพิมพ หรือ 

keyboard และเมื่อหยุดการบันทึกแลวจะเกิดหนาตาง Save Project Files เพื่อใหตั้งคาการบันทึก

ชิ้นงานหรือโปรเจ็คของเรา  

 

 

รูปภาพ หนาตาง Save Project Files 

 

1.Project Name ช่ือไฟลงาน (ในตัวอยางจะใชช่ือ unititled)  

** เนื่องจากเราสามารถเลือก Option ของ Recording Mode(s) 

ไดมากกวา 1 รูปแบบ หรือ ทั้ง 4 รูปแบบพรอมๆ กันได โดยที่

โปรแกรมจะแยกการบนัทึกใหในแตละรูปแบบโดยอัตโนมัติ 

และชื่อที่ไดตัง้ที่ Project Name ก็จะไปปรากฏที่ช่ือไฟลงานของ

ทุก Option โดยอัตโนมัติเชนกัน ทําใหไมตองไปตั้งชื่อไฟลงาน

ในทุก Option ดังตัวอยางรูปภาพ**  
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รูปภาพ การต้ังชื่อ Project Name ท่ีหนาตาง Save Project Files 

 

2.Project Directory ตําแหนงในการเก็บชิ้นงานหรือโปรเจ็ค (ในตัวอยางจะเกบ็ไวที่ 

Drive D) 

3.Demo Project Name ** ถา Option ของ Recording Mode(s) เราเลือก Demonstration 

ก็จะมกีลองขอความแสดงชื่อไฟลงานขึ้นมา เพราะฉะนั้นชื่อของ
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ไฟลงานเริ่มตนจะตองตอทายดวย _demo เสมอ (ช่ือไฟล

งาน_demo)** 

4.Training Project Name คือช่ือไฟลงานที่เราไดตั้งไวที่ Project Name ตามดวย _training 

(ในตวัอยางจะใชช่ือ unititled_training) เนื่องจาก Option ของ 

Recording Mode(s) ที่เราไดเลือกไว คือ Training Simulation 

เพราะฉะนั้นชือ่ของไฟลงานจะตองตอทายดวย _training เสมอ 

5.Assessment Project Name ** ถา Option ของ Recording Mode(s) เราเลือก Assessment ก็จะ

มีกลองขอความแสดงชื่อไฟลงานขึ้นมา เพราะฉะนัน้ชื่อของไฟล

งานเริ่มตนจะตองตอทายดวย _assessment เสมอ (ช่ือไฟล

งาน_assessment)** 

6.Custom Project Name ** ถา Option ของ Recording Mode(s) เราเลือก Custom ก็จะมี

กลองขอความแสดงชื่อไฟลงานขึ้นมา เพราะฉะนัน้ชื่อของไฟล

งานเริ่มตนจะตองตอทายดวย _ custom เสมอ (ช่ือไฟลงาน_ 

custom)** 

7.Project To Open คือ การตั้งคาวาเมื่อ save ช้ินงานหรือโปรเจ็คที่เราทําแลว 

ตองการใหโปรแกรมเปดชิ้นงานของ Recording Mode(s) แบบ 

Option ไหนขึน้มาเพื่อดหูรือปรับแกไขตอ (ในตวัอยางเราได

เลือกแบบ Training Simulation) 

** Project To Open จะแสดง Option ใหเราเลือกเทากับการตั้ง

คาที่ Option ของ Recording Mode(s) ** 

 

** สิ่งท่ีควรคํานึงถึงของการ Save Project Files เพื่อตั้งคาการบันทึกชิน้งานหรือโปรเจ็ค ** 

 1. การตั้งชื่อไฟลงานที่ตอทายดวย Option ของ Recording Mode(s) ที่เราเลือก เชน ตัวอยาง 

unititled_training เราสามารถแกไขชื่อไฟลงานไดตามความตองการ ซ่ึง _training นั้นเปนคาเบื้องตน 
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(Defult) ที่โปรแกรมตั้งไวเพื่อแยกประเภทของชิ้นงานหรือโปรเจ็คใหผูทําไดรูวาเปน Recording Mode(s) 

Option แบบใด  

2. ในกรณีที่เราเลือก Option ของ Recording Mode(s) มากกวา 1 แบบ ซ่ึงโปรแกรมจะแยกการ

บันทึกใหในแตละรูปแบบโดยอัตโนมัติ เราสามารถแกไขชื่อไฟลงานไดตามความตองการ แตไมควรตั้งชื่อ

งานใหเหมือนกันทุก Option เพราะโปรแกรมจะไมบันทกึชิ้นงานหรือโปรเจ็คของเรา ดังตัวอยางรูปภาพ 

 

 

 

รูปภาพ การต้ังชื่อ Project Name ซ้ํากัน ท่ีหนาตาง Save Project Files 

 

3. การตั้งชื่อไฟลงานนั้นควรตั้งชื่อใหครบทุกชอง ทั้ง Project Name และ Option ของ Recording 

Mode(s) ที่มีดวย เพราะโปรแกรมจะไมบนัทึกชิ้นงานหรือโปรเจ็คของเรา ดังตัวอยางรูปภาพ 

Training Project Name ต้ังชื่อไฟลงานวา untitled 

Custom Project Name ต้ังชื่อไฟลงานวา untitled 
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รูปภาพ การไมต้ังชื่อ Project Name ท่ีหนาตาง Save Project Files 

 

• เม่ือเรา save ชิ้นงานหรือโปรเจ็คท่ีเราทําไดแลว โปรแกรมก็เปดชิ้นงานของ Recording Mode(s) ใน

รูปแบบ Option ท่ีเราเลือกไวขึ้นมาเพื่อใหดหูรือปรับแกไขตอ (ในตัวอยางเราไดเลือกแบบ Training 

Simulation) 

 

Training Project Name 

ไมไดต้ังชื่อไฟลงาน
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รูปภาพ เม่ือ save ชิ้นงานหรือโปรเจ็คเสร็จ 

 โปรแกรมจะเปดชิ้นงานของ Recording Mode(s) ในรูปแบบ Option ท่ีเราเลือกไวขึ้นมาเพื่อใหดูหรือปรับแกไขตอ 

 

• และชิ้นงานที่ไดมาจากการ Record บันทึกภาพหนาจอ ของการสาธิตวธีิการแทรกไฟลภาพใน

โปรแกรม Microsoft Word นั้นจะมีท้ังหมด 5 Slide ใหเราเลือกมุมมองแบบ Edit แกไข เพิ่มเติม 

องคประกอบ (Object) ตางๆ ในสไลด  
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รูปภาพ มุมมอง edit  เพื่อแกไข เพิ่มเติมองคประกอบ (Object) ตางๆ ในสไลด 

 

• Slide 1 การกดปุมแทรก (Insert) เพื่อนําภาพเขามา 

โปรแกรมไดสราง เคร่ืองมือ หรือ Object ขึ้นใหโดยอตัโนมัติ คือ กรอบขอความสําหรับคลิก (Click 

Box) 

กรอบขอความสําหรับคลิก (Click Box) เปนสิ่งที่มีการทํางานทุกอยางคลายกับปุม โดยเฉพาะปุม 

Transparent  Button เพราะกรอบคลิกจะไมมีรูป หรือ ภาพที่ทําใหเรามองเห็นได แตจะมีเพยีงกรอบสี่เหล่ียม

เพื่อกําหนดเปนพื้นที่เพื่อระบุวา ถาคลิกในบริเวณพื้นทีท่ี่เรากําหนดไวนั้นจะเกิดการตอบโตขึ้น 

โดยกรอบขอความสําหรับคลิก (Click Box) นี้ โปรแกรมจะวางไวในตําแหนงที่เราไดทําการจับ

ภาพไวในตอนสาธิตใหโดยอัตโนมัติ ซ่ึงในที่นี้ก็คือ บริเวณปุมแทรก (Insert) 

และโปรแกรมจะตั้งคาใหมี Option เพิ่มเตมิใหอัตโนมัตอีิกดวย คือ 

1.Failure caption แสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความผิดพลาดเมื่อคลิกปุมผิด 
คือ กลองขอความสีแดง สําหรับใสขอความเพื่อบอกกับผูเรียนวาตอบผิดหรือเปนคําสั่ง

เพื่อใหผูเรียนไดทําตามใหถูกตอง เพราะกลองขอความนี้จะปรากฏขึ้นมาเมื่อผูเรียนคลิกไมตรง

คลิกท่ี Edit 
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ตามที่เราไดจบัภาพหนาจอไวหรือคลิกผิดที่ 
2.Hint caption แสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิกปุม 

คือ กลองขอความสีเหลือง สําหรับใสขอความเพื่อใชเปนแนวทางหรอืไกดไลนวาจะให

ผูเรียนทําอะไรเมื่อไดเขาใกลบริเวณหรือตําแหนงที่ถูกตอง  

โดยใน Slide ท่ี 1 เปนขั้นตอนแรกของการวิธีการแทรกไฟลภาพในโปรแกรม Microsoft Word นัน่

ก็คือ การกดปุมแทรก (Insert) เพื่อนําภาพเขามา 

ผูเรียนตองกดปุมแทรก (Insert) ถึงจะเปนคําตอบที่ถูกตอง แลวจะสามารถไปสูขัน้ตอนตอไปหรอื

หนาถัดไปได  แตถาผูเรียนตอบไมถูกก็ไมสามารถไปตอได และในระหวางที่ผูเรียนกาํลังหาคําตอบถาผูเรียน

คลิกผิดท่ีก็จะปรากฏกลองขอความสีแดงขึน้มาเพื่อบอกกับผูเรียนวาตอบผิดหรือเปนคําสั่งเพื่อใหผูเรียนได

ทําตามใหถูกตอง หรือถาผูเรียนไดเขาใกลบริเวณหรือตําแหนงท่ีถูกตองแลวก็จะปรากฏกลองขอความสี

เหลืองขึ้นมา  

 

 

รูปภาพ Slide 1  คือ การกดปุมแทรก (Insert) เพื่อนําภาพเขามา 

กลองขอความสีแดง  

(Failure Caption)

กลองขอความสีเหลือง 

(Hint Caption) 

กรอบขอความสําหรับ

คลิก (Click Box)



จัดทําโดย อทุยานการเรียนรู TK parkและมูลนิธิอนิเทอรเนต็รวมพัฒนาไทย@2553                                                                                                                          137 

 

• Slide 2  คือ การกดปุมแทรกรูปภาพจากแฟม (Insert Picture from File) 

โปรแกรมไดสราง เคร่ืองมือ หรือ Object ขึ้นใหโดยอตัโนมัติ คือ กรอบขอความสําหรับคลิก (Click 

Box) 

กรอบขอความสําหรับคลิก (Click Box) เปนสิ่งที่มีการทํางานทุกอยางคลายกับปุม โดยเฉพาะปุม 

Transparent  Button เพราะกรอบคลิกจะไมมีรูป หรือ ภาพที่ทําใหเรามองเห็นได แตจะมีเพยีงกรอบสี่เหล่ียม

เพื่อกําหนดเปนพื้นที่เพื่อระบุวา ถาคลิกในบริเวณพื้นทีท่ี่เรากําหนดไวนั้นจะเกิดการตอบโตขึ้น 

โดยกรอบขอความสําหรับคลิก (Click Box) นี้ โปรแกรมจะวางไวในตําแหนงที่เราไดทําการจับ

ภาพไวในตอนสาธิตใหโดยอัตโนมัติ ซ่ึงในที่นี้ก็คือ บริเวณปุมแทรกรปูภาพจากแฟม (Insert Picture from 

File) 

และโปรแกรมจะตั้งคาใหมี Option เพิ่มเตมิใหอัตโนมัตอีิกดวย คือ 

1.Failure caption แสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความผิดพลาดเมื่อคลิกปุมผิด 

คือ กลองขอความสีแดง สําหรับใสขอความเพื่อบอกกับผูเรียนวาตอบผิดหรือเปนคําสั่งเพื่อให

ผูเรียนไดทําตามใหถูกตอง เพราะกลองขอความนี้จะปรากฏขึ้นมาเมื่อผูเรียนคลิกไมตรงตามที่เราได

จับภาพหนาจอไวหรือคลิกผิดที่ 

2.Hint caption แสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิกปุม 

คือ กลองขอความสีเหลือง สําหรับใสขอความเพื่อใชเปนแนวทางหรอืไกดไลนวาจะใหผูเรียน

ทําอะไรเมื่อไดเขาใกลบริเวณหรือตําแหนงที่ถูกตอง  

โดยใน Slide ท่ี 2 เปนขั้นตอนตอไปหลังจากกดปุมแทรกภาพแลว คอื การกดปุมแทรกรูปภาพจาก

แฟม (Insert Picture from File) 

ผูเรียนจะตองกดปุมแทรกรูปภาพจากแฟม (Insert Picture from File) ถึงจะเปนคําตอบที่ถูกตอง 

แลวจะสามารถไปสูขัน้ตอนตอไปหรือหนาถัดไปได  แตถาผูเรียนตอบไมถูกก็ไมสามารถไปตอได และใน

ระหวางที่ผูเรียนกําลังหาคําตอบถาผูเรียนคลิกผิดท่ีก็จะปรากฏกลองขอความสีแดงขึน้มาเพื่อบอกกับผูเรียน
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วาตอบผดิหรอืเปนคําสัง่เพื่อใหผูเรียนไดทําตามใหถูกตอง หรือถาผูเรียนไดเขาใกลบริเวณหรือตําแหนงท่ี

ถูกตองแลวก็จะปรากฏกลองขอความสีเหลืองขึ้นมา  

 
รูปภาพ Slide 2  คือ การกดปุมแทรกรูปภาพจากแฟม (Insert Picture from File) 

 

• Slide 3  คือ การกดเลือกรูปเพื่อแทรกลงไปในเอกสาร (Insert Picture) 

โปรแกรมไดสราง เคร่ืองมือ หรือ Object ขึ้นใหโดยอตัโนมัติ คือ กรอบขอความสําหรับคลิก (Click 

Box) 

กรอบขอความสําหรับคลิก (Click Box) เปนสิ่งที่มีการทํางานทุกอยางคลายกับปุม โดยเฉพาะปุม 

Transparent  Button เพราะกรอบคลิกจะไมมีรูป หรือ ภาพที่ทําใหเรามองเห็นได แตจะมีเพยีงกรอบสี่เหล่ียม

เพื่อกําหนดเปนพื้นที่เพื่อระบุวา ถาคลิกในบริเวณพื้นทีท่ี่เรากําหนดไวนั้นจะเกิดการตอบโตขึ้น 

โดยกรอบขอความสําหรับคลิก (Click Box) นี้ โปรแกรมจะวางไวในตําแหนงที่เราไดทําการจับ

ภาพไวในตอนสาธิตใหโดยอัตโนมัติ ซ่ึงในที่นี้ก็คือ บริเวณรูปภาพเพือ่แทรกลงไปในเอกสาร 

และโปรแกรมจะตั้งคาใหมี Option เพิ่มเตมิใหอัตโนมัตอีิกดวย คือ 

กลองขอความสีแดง  

(Failure Caption)

กลองขอความสีเหลือง 

(Hint Caption) 

กรอบขอความสําหรับ

คลิก (Click Box)
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1.Failure caption แสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความผิดพลาดเมื่อคลิกปุมผิด 

คือ กลองขอความสีแดง สําหรับใสขอความเพื่อบอกกับผูเรียนวาตอบผิดหรือเปนคําสั่ง

เพื่อใหผูเรียนไดทําตามใหถูกตอง เพราะกลองขอความนี้จะปรากฏขึ้นมาเมื่อผูเรียนคลิกไมตรง

ตามที่เราไดจบัภาพหนาจอไวหรือคลิกผิดที่ 

2.Hint caption แสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิกปุม 

คือ กลองขอความสีเหลือง สําหรับใสขอความเพื่อใชเปนแนวทางหรอืไกดไลนวาจะให

ผูเรียนทําอะไรเมื่อไดเขาใกลบริเวณหรือตําแหนงที่ถูกตอง  

โดยใน Slide ท่ี 3 เปนขั้นตอนตอไปหลังจากกดปุมแทรกรูปภาพจากแฟม (Insert Picture from 

File) นั่นก็คือ การกดเลือกรูปเพื่อแทรกลงไปในเอกสาร (Insert Picture) 

ผูเรียนจะตองเลือกรูปภาพจากแฟม (Insert Picture) ถึงจะเปนคําตอบที่ถูกตอง แลวจะสามารถไปสู

ขั้นตอนตอไปหรือหนาถัดไปได  แตถาผูเรียนตอบไมถูกก็ไมสามารถไปตอได และในระหวางที่ผูเรียนกําลัง

หาคําตอบถาผูเรียนคลิกผิดท่ีก็จะปรากฏกลองขอความสีแดงขึน้มาเพื่อบอกกับผูเรียนวาตอบผดิหรือเปน

คําสั่งเพื่อใหผูเรียนไดทําตามใหถูกตอง หรือถาผูเรียนไดเขาใกลบริเวณหรือตําแหนงท่ีถูกตองแลวก็จะ

ปรากฏกลองขอความสีเหลืองขึ้นมา  
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รูปภาพ Slide 3  การกดเลือกรูปเพื่อแทรกลงไปในเอกสาร (Insert Picture) 

 

• Slide 4  คือ การกดปุมแทรก (Insert Button) 

โปรแกรมไดสราง เคร่ืองมือ หรือ Object ขึ้นใหโดยอตัโนมัติ คือ กรอบขอความสําหรับคลิก (Click 

Box) 

กรอบขอความสําหรับคลิก (Click Box) เปนสิ่งที่มีการทํางานทุกอยางคลายกับปุม โดยเฉพาะปุม 

Transparent  Button เพราะกรอบคลิกจะไมมีรูป หรือ ภาพที่ทําใหเรามองเห็นได แตจะมีเพยีงกรอบสี่เหล่ียม

เพื่อกําหนดเปนพื้นที่เพื่อระบุวา ถาคลิกในบริเวณพื้นทีท่ี่เรากําหนดไวนั้นจะเกิดการตอบโตขึ้น 

โดยกรอบขอความสําหรับคลิก (Click Box) นี้ โปรแกรมจะวางไวในตําแหนงที่เราไดทําการจับ

ภาพไวในตอนสาธิตใหโดยอัตโนมัติ ซ่ึงในที่นี้ก็คือ ปุมแทรก (Insert Button) 

และโปรแกรมจะตั้งคาใหมี Option เพิ่มเตมิใหอัตโนมัตอีิกดวย คือ 

1.Failure caption แสดงขอความอธิบาย (Text Caption) ที่บอกแสดงความผิดพลาดเมื่อคลิกปุมผิด 

กลองขอความสีแดง  

(Failure Caption) 

กลองขอความสีเหลือง 

(Hint Caption) 

กรอบขอความสําหรับ

คลิก (Click Box)
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คือ กลองขอความสีแดง สําหรับใสขอความเพื่อบอกกับผูเรียนวาตอบผิดหรือเปนคําสั่งเพื่อให

ผูเรียนไดทําตามใหถูกตอง เพราะกลองขอความนี้จะปรากฏขึ้นมาเมื่อผูเรียนคลิกไมตรงตามที่เราได

จับภาพหนาจอไวหรือคลิกผิดที่ 

2.Hint caption แสดงขอความอธิบาย (Text Caption) ที่บอกใบในการคลิกปุม 

คือ กลองขอความสีเหลือง สําหรับใสขอความเพื่อใชเปนแนวทางหรอืไกดไลนวาจะใหผูเรียน

ทําอะไรเมื่อไดเขาใกลบริเวณหรือตําแหนงที่ถูกตอง  

โดยใน Slide ท่ี 4 เปนขั้นตอนตอไปหลังจาก การเลือกรูปเพื่อแทรกลงไปในเอกสาร (Insert 

Picture) นั่นกค็ือ การกดปุมแทรก (Insert Button) 

ผูเรียนจะตองกดปุมแทรก (Insert Button) ถึงจะเปนคําตอบที่ถูกตอง แลวจะสามารถไปสูขัน้ตอน

ตอไปหรือหนาถัดไปได  แตถาผูเรียนตอบไมถูกก็ไมสามารถไปตอได และในระหวางที่ผูเรียนกําลังหา

คําตอบถาผูเรียนคลิกผดิท่ีก็จะปรากฏกลองขอความสีแดงขึ้นมาเพื่อบอกกับผูเรียนวาตอบผดิหรือเปนคําสัง่

เพื่อใหผูเรียนไดทําตามใหถูกตอง หรือถาผูเรียนไดเขาใกลบริเวณหรือตําแหนงท่ีถูกตองแลวก็จะปรากฏ

กลองขอความสีเหลืองขึ้นมา  
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รูปภาพ Slide 4  การกดปุมแทรก (Insert Button) 

 

• Slide 5  คือ การแทรกไฟลภาพในโปรแกรม Microsoft Word เสร็จสมบูรณ 

โปรแกรมไดสราง Animation เปนพื้นหลงัของพรอมกับการเคลื่อนไหวที่ไดสรางไว 

โดยใน Slide ท่ี 5 เปนขั้นตอนสุดทายของการแทรกไฟลภาพในโปรแกรม Microsoft Word ซ่ึงไม

ตองมีการโตตอบใดๆ กับผูเรียน 

กลองขอความสีแดง  

(Failure Caption)

กลองขอความสีเหลือง 

(Hint Caption)

กรอบขอความสําหรับ

คลิก (Click Box)
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รูปภาพ Slide 5  แทรกไฟลภาพในโปรแกรม Microsoft Word เสร็จสมบูรณ 

 

• เราสามารถดูตวัอยางงานได โดย กด F3 เพื่อแสดงสไลดท่ีเรากําลังทําอยู  หรือ กด F4 เพื่อแสดงทั้ง

โปรเจ็กต  

 

 


